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About This User Manual

This user manual describes the configuration of the IEC 61850 Connect in 800xA.

The main topics covered in this user manual are:

• Introduction to IEC 61850 Connect.

• Workflow for Configuration of IEC 61850 Connect OPC Server.

• IEC 61850 Uploader Tool Workflow.

• Alarm and Event Configuration.

• Workflow for Addition/Modification of Graphic Elements.

• Guidelines for Import and Export.

• Backup Restore Guidelines.

• Reconfiguration of SCD files.

• Guidelines for Creating User Defined BU Specific Libraries.

The user should have adequate knowledge of the 800xA control system and IEC 
61850 protocol in general.

Any security measures described in this User Manual, for example, for user 
access, password security, network security, firewalls, virus protection, etc., 
represent possible steps that a user of an 800xA System may want to consider 
based on a risk assessment for a particular application and installation. This risk 
assessment, as well as the proper implementation, configuration, installation, 
operation, administration, and maintenance of all relevant security related 
equipment, software, and procedures, are the responsibility of the user of the 
800xA System.
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The application engineers or the engineers who plan the design or implementation 
of IEC 61850 as a part of substation automation, are intended to use this user 
manual. The users should be familiar with the hardware and software functionalities 
of the 800xA system products.

The following are included in this user manual.

Section 1, Introduction, provides a brief overview of 800xA IEC 61850 Connect.

Section 2, 800xA IEC61850 OPC Server, describes the functionality of IEC 61850 
Connect OPC Server and Configuration.

Section 3, 800xA IEC 61850 Uploader, describes the functionality and working 
procedure of IEC 61850 Uploader aspect of Plant Explorer.

Section 4, 800xA IEC 61850 Alarm and Event Configuration, describes the 
configuration of alarms and events with 800xA IEC 61850 Connect.

Section 5, Addition and Modification of Graphic Elements, describes how to create 
and modify user defined Faceplates and Graphic Elements.

Section 6, Guidelines to Import and Export, describes the guidelines on using 
Import and Export.

Section 7, Reconfiguration, describes the reconfiguration of SCD files.

Section 8, Object Type Specific Graphics for BAY, describes the development of 
Object type specific faceplate for BAY.

Section 9, Object Type Specific Graphics for IED, describes the development of 
Object type specific faceplate for IED.

Section 10, Guidelines for Creating User Defined/BU Specific Libraries, describes 
the guidelines for Creating User Defined BU Specific Libraries.

Section 11, SCD Information, describes provides the SCD information for the IEC 
61850 Uploader and the OPC Server.

User Manual Conventions
Microsoft Windows conventions are normally used for the standard presentation of 
material when entering text, key sequences, prompts, messages, menu items, screen 
elements, etc.
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Feature Pack

The Feature Pack content (including text, tables, and figures) included in this 
User Manual is distinguished from the existing content using the following 
two separators:

Feature Pack Functionality______________________________________________________________________

<Feature Pack Content>

___________________________________________________________________________________________

Feature Pack functionality included in an existing table is indicated using a 
table footnote (*):
*Feature Pack Functionality

Unless noted, all other information in this User Manual applies to 800xA Systems 
with or without a Feature Pack installed.

Warning, Caution, Information, and Tip Icons

This User Manual includes Warning, Caution, and Information where appropriate to 
point out safety related or other important information. It also includes Tip to point 
out useful hints to the reader. The corresponding symbols should be interpreted as 
follows:

Electrical warning icon indicates the presence of a hazard that could result in 
electrical shock.

Warning icon indicates the presence of a hazard that could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard that could result 
in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function
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Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
fully comply with all Warning and Caution notices.

Terminology
A complete and comprehensive list of Terms is included in the System 800xA, 
Engineering Concepts Instruction (3BDS100972*). The listing includes terms and 
definitions that apply to the 800xA System where the usage is different from 
commonly accepted industry standard definitions and definitions given in standard 
dictionaries such as Webster’s Dictionary of Computer Terms. Terms that uniquely 
apply to this User Manual are listed in the following table.

Term/Acronym Description

800xA ABB automation system (eXtended Automation).

AC 800M ABB Controller 800M series, general purpose process 
controller series by ABB.

AC 800M Controller Any controller constructed from the units and units 
connected to the AC 800M hardware platform.

AE Alarm and Event.

Append Function for creating objects (based on Object Types) in 
the 800xA Control Structure.

CCT Communication Configuration Tool.

CDC Common Data Class.

CET Communication Engineering Tool.

DA Data Access.

FBD Feeder Block Diagram.

GCB GOOSE Control Block.

ICD IED Capability Description. A type of SCL file.
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IEC International Electrotechnical Commission.

IEC 61850 IEC standard for Communication Networks and Systems 
in Substations.

• 800xA IEC 61850-Ed1 (Edition1) reference to the 
Edition1 of the specification is supported

• Ed2 reference to the Edition 2. Parts of the 
specification are updated time by time and indicated 
with a new edition number.

IED Intelligent Electronic Device.

IET Integrated Engineering Tool.

LD Logical Device: A virtual device which enables 
aggregation of Logical Nodes and Data sets for 
communication purposes. Additionally, Logical Devices 
contain convenient lists of frequently accessed or 
referred to information. For example, data sets.

LN Logical Node.

LON A communication protocol. 

MMS Manufacturing Message Specification (MMS) is an 
international standard (ISO 9506) dealing with 
messaging system for transferring real time process data 
and supervisory control information between networked 
devices and/or computer applications.

Node A computer communicating on a network, for example 
the Internet, Plant, Control or IO network. Each node 
typically has a unique node address with a format 
depending on the network it is connected to.

OCS Open Control System.

OPC OLE for Process Control. A set of standard interfaces 
based on COM technology.

OT Object Type, object template in Object Type Structure in 
800xA.

Term/Acronym Description
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Released User Manuals and Release Notes
A complete list of all User Manuals and Release Notes applicable to System 800xA 
is provided in System 800xA Released User Manuals and Release Notes 
(3BUA000263*).

System 800xA Released User Manuals and Release Notes (3BUA000263*) is 
updated each time a document is updated or a new document is released. It is in pdf 
format and is provided in the following ways:

• Included on the documentation media provided with the system and published 
to ABB SolutionsBank when released as part of a major or minor release, 
Service Pack, Feature Pack, or System Revision.

• Published to ABB SolutionsBank when a User Manual or Release Note is 
updated in between any of the release cycles listed in the first bullet.

PPA Process Portal A.

RCB Report Control Block

Retrieve Function for collecting information regarding a control 
network.

SA Substation Automation.

SCD Substation Configuration Description, type of SCL file.

SCL Substation Configuration Language.

SLD Single Line Diagram.

SPA ABB proprietary communication protocol used in 
substation automation.

Upload Retrieve + Append.

XML eXtensible Markup Language.

A product bulletin is published each time System 800xA Released User Manuals 
and Release Notes (3BUA000263*) is updated and published to ABB 
SolutionsBank.

Term/Acronym Description
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Section 1  Introduction

IEC stands for International Electrotechnical Commission and IEC 61850 is an IEC 
standard for Communication Networks and Systems in Substations.

800xA IEC 61850 Connect Package
800xA IEC 61850 Connect integrates the IEC 61850 network with 800xA system. 
The solution is based on the Standard Connectivity functionality in 800xA where 
the subsystems are integrated to the 800xA system using the OPC Servers (Data 
Access and Alarm and Event). The IEC 61850 Connect uses the IEC 61850 OPC 
Server.

This section gives an overview of IEC 61850 Connect. The IEC 61850 Objects 
include the logical node objects that are specified in the IEC 61850 -Ed1 (Edition1) 
standard. It also includes additional generic objects and functional objects such as 
breakers and transformers, which represent the substation functional view in the 
800xA. These object types act as a database for creation of communication structure 
and Substation structure of SCD file in 800xA. An Uploader creates these structures 
in 800xA system automatically by reading the SCD file. The IEC 61850 OPC 
Server provides data from IEC 61850 network to 800xA.

The IEC 61850 Connect is included as a system extension and the object types are 
bundled within this system extension. Configuration Wizard is used to load this 
system extension onto 800xA.

The following are the components of the IEC 61850 Connect package:

1. IEC 61850 OPC Server 

IEC 61850 OPC Server consists of the IEC 61850 OPC DA Server and the IEC 
61850 OPC AE Server. It also contains the Communication Engineering Tool 
(CET) which is used to configure the OPC Server.
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2. IEC 61850 Connect

a. 800xA Object types representing IEC 61850 entities such as Substation, 
Voltage Level, Substation Network, IED, Conducting Equipments, 
Logical devices, Logical Nodes, and OPC Servers.

b. The Uploader Aspect.

c. Default Alarm Collection Definition Aspect.

d. All the above and other associated functionalities are delivered as IEC 
61850 Connect system extension.

3. SCL Model Components

SCL Model components contain a set of libraries that are used to parse the 
SCD file during upload.

IEC 61850 OPC Server requires the SCD file describing the IEDs and the IEC 
61850 subnetwork. The IEDs are expected to support reporting and control services.

Object Types

The IEC 61850 Object Type Library contains the following object types:

• Substation Object

This object contains an Control Connection aspect, which consists of attributes 
of the Substation.

• Voltage level Object

This object contains an Control Connection aspect, which consists of attributes 
of the Voltage level.

• OPC Server Object

This is the topmost object in the hierarchy, which contains the IEC 61850 
Uploader aspect and OPC Data Source Definition aspects.

• Subnetwork Object

This represents IEC 61850 Subnetwork in 800xA. This contains Control 
Connection aspect, which consists of attributes of the Subnetwork.

• IED Object
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This object type contains a Control Connection aspect, which consists of 
IED’s attributes.

• Logical Node Object 

These object types are as per the IEC 61850-Ed1 standard. Each defined logical 
node type is mapped to an object type.

• Generic Logical Node Object

This serves as a generic object for Logical Nodes.

• Logical Device Object

This object contains an Control Connection aspect.

• Conducting Equipment Object

This object contains object types corresponding to the Functional Objects and 
the Conducting Equipment Objects. 

Figure 1 shows a sample screen shot of Object Type Structure displaying the IEC 
61850 Base Library with all objects.
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Figure 1. IEC 61850 Base Library displaying all objects
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IEC 61850 Connect System Topology 

800xA IEC 61850 Connect integrates the IEC 61850 Network and 800xA systems 
using the IEC 61850 OPC Server. The data of the various IEDs on the IEC 61850 
network is read by the IEC 61850 OPC Server facilitating the vertical 
communication as defined in the IEC 61850 -Ed1 standard. Only the MMS 
(Manufacturing Message Specification) based signals on the IEC 61850 bus are read 
by the IEC 61850 OPC Server and given to the 800xA client. Figure 2 shows the 
typical IEC 61850 Connect System Topology. 

Figure 2. IEC 61850 Connect System Topology
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Section 2  800xA IEC61850 OPC Server

The IEC61850 OPC Server enables Operator workplaces as 800xA OPC clients to 
access the process data from IEC 61850 IEDs, such as protection and control 
devices communicating through the IEC 61850 protocol.

The OPC Server implements both the DA (Data Access) and AE (Alarm and 
Events) functionality. To create a common data interface between the OPC server 
and the operator workplace in 800xA or IEC 61850 IED, the process data is 
modelled using the IEC 61850 protocol.

The IEC 61850 specifies the usage of Manufacturing Message Specification (MMS, 
ISO 9506) over TCP/IP as communication between the IEC 61850 server and client 
(device/IEC 61850 OPC Server).

After the IEC 61850 OPC Server and other required components have been 
installed, the SCD file containing hierarchically structured models of a substation 
can be imported into IEC 61850 OPC Server using the Communication Engineering 
Tool (CET).

The configuration data is stored in SCL (XML based) format. After the IEC 61850 
OPC Server has been launched, it reads the configuration file and establishes 
communication with the IEC 61850 devices through the IEC 61850 protocol stack. 
Configured IEC 61850 devices and their data are then exposed to OPC clients 
through an OPC Data Access (DA) server and device reported changes in data with 
DA subscription are reported to OPC clients.

IEC 61850 OPC Server Features
The IEC 61850 -Ed1 OPC Server supports the following features:

• OPC Data Access v. 1.0/2.0.

• OPC Alarms and Events specifications v. 1.10.
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• Communication diagnostics.

• IEC 61850 data modeling.

• System supervision:

– IEC 61850 device communication

• Command handling:

– The IEC 61850 OPC Server supports the IEC 61850 command services.

• IEC 61850 -Ed1 data objects:

– SPS, DPS, INS, ACT, ACD, SEC, BCR, MV, CMV, SAV, WYE, DEL, 
SEQ, SPC, DPC, BSC, ISC, APC, SPG, ING, ASG, CURVE, DPL, LPL.

• IEC 61850 buffered and unbuffered reporting services.

• IEC 61850 File Transfer.

• Automatic Disturbance Recording upload using IEC 61850 file transfer or 
FTP.

• Time synchronization:

– The IEC 61850 OPC Server can act as an SNTP client and server for time 
synchronization. When the IEC 61850 OPC Server is configured for 
receiving time synchronization, it updates the operating system time of the 
PC.

• Multiple instance support when installed on the same hardware platform.

CET Alarm and Event Object Properties

Event Categories

Event Categories are defined in the Common Event Settings node below the 
Computer Node object. Event categories are assigned to event definitions with the 
corresponding Simple Event Category and Condition Event Category properties 
on the event definition objects.
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It is possible to create custom event categories and assign to event definitions. Based 
on the categories, OPC A&E clients filter events, such as process or system events.

Event categories must be created for each event type (simple or condition). For 
example, categories Process Simple Event and Process Condition Event must be 
created for process events.

Event Definitions

Event definitions specify the type of events that are created for HMI event and alarm 
lists. It can be configured whether an event appears only on the event list, on both 
event and alarm lists, or none. Event texts can be added for the events specify 
whether alarms must be acknowledged by the user. 

To create event definition:

Figure 3. Event Categories Definition



Event Definitions Section 2  800xA IEC61850 OPC Server

28 9ARD171387-510 D

1. Right-click any Events group in CET.

2. Select New > Event classes.

3. Select the event class to add. 

The new event class appears in the Process Definitions below the selected event 
group. Enter a unique name for the event class by right-clicking it and selecting 
Rename. The new event class can be configured and connected to a data object.

To configure event definitions:

1. Select an event to configure in the object tree. 

2. The object properties appear in the Object Properties window.

Figure 4. Example of Event Definitions - Event Class
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3. Assign the event with parameter values.

Event definitions are linked to data objects by configuring the event properties 
available for data objects. When importing IED configurations from IED SCL 
description files, event definitions are linked to data objects by default. For example 
switch position data object CSWIx.Pos is linked by default to switch position event 
definition. The default linking rules are specified in a DOParamsDefaults.xml file 
located in the \Program Files\ABB\61850 OPC Server\CET\bin\Tools\SCLImport in 
the computer where CET is installed.

Figure 5. Example of Event Definition Properties
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CET Objects Properties
Object properties of all imported objects can be configured from CET.

Perform the following steps to configure an object:

1. Select an object in the Communication structure’s object tree and all available 
properties are listed on the right side window.

2. Select the required property to be configured.

According to the property value type, manually configure or select a predefined 
value from a drop-down combo box.

Objects with configuration from an existing SCD file can be imported using SCL 
import function. 

IEC 61850 OPC Server Object Properties

Table 1 lists the configurable IEC 61850 OPC Server object properties and value 
ranges for them.

Table 1. IEC 61850 OPC Server Object Properties

Name Value/Value Range Description

Basic

AE Prog ID -/- Prog ID for OPC Alarm and Event Server 
(Automatically generated by management 
function).

DA Prog ID -/- Prog ID for OPC Data Access Server 
(Automatically generated by management 
function).

Enable reading of 
dattribute 
(description) from 
IED

True

False

Default: False

Specifies whether the d attribute (description) is 
read from the IED. Normally d is not reported 
from the IED. It is only read if read operation is 
requested e.g. with Online Diagnostics. When 
set to false, the text of the data object 
Description property is used.

SNTP Client
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Address for SNTP 
Server

-/- IP address or node name for SNTP Server 
(Primary).

There are four sets applicable for this property.

Port Number (1..65535)

Default: 123

TCP/IP port number of SNTP Server.

There are four sets applicable for this property.

Synchronization 
Interval

(0..3600)

Default: 15

Time synchronization interval in seconds. If 
value is 0, no time synchronization will be done.

There are four sets applicable for this property.

SNTP Enable 
Client

True

False

Default: True

Controls if time synchronization client is initially 
in use or not.

SNTP Server

Enable Time 
Synchronization 
server

True

False

Default: True

Controls if time synchronization server is initially 
in use or not.

Port Number For 
Time 
Synchronization

Server

(1...65535)

Default: 123

Port number for time synchronization server.

Communication Control

Report Control 
Identity

Default: Client1 Report Control Identity is the OPC server name 
and it must identical with the name given under 
each IED Report control Block configuration. 
Only when the names are equal the 
communication between IED server and OPC 
client will be established.

Table 1. IEC 61850 OPC Server Object Properties (Continued)

Name Value/Value Range Description
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Server Originator 
Category

Control operation issued 
from an operator using a 
client located at station 
level.

Control operation issued 
from an unknown 
location.

Control operation from a 
remote operator outside 
the substation (for 
example network control 
center).

Default: Control operation 
issued from an operator 
using a client located at 
station level.

Specifies the default originator category that is 
used for changing values and IEC 61850 control 
services. This can be overridden by the OPC 
Client for DPC control.

Table 1. IEC 61850 OPC Server Object Properties (Continued)

Name Value/Value Range Description
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IEC 61850 Subnetwork Object Properties

Table 2 lists the IEC 61850 Subnetwork object properties that can be configured and 
value ranges for them. 

Server Originator 
Identification

Free string (max length 64 
characters). For numeric 
values hex code can be 
used (starting with "0x" e.g. 
0xABB).

Default: ABB

Specifies the default originator identification that 
is used for IEC 61850 control services.

System Event 
Level

Disabled

Level 1 (main operation 
and errors)

Level 2 (time 
synchronization errors)

Level 3 (time 
synchronization done)

Level 4 (reported local 
updates from devices)

Level 5 (reported 
unconfigured updates from 
devices)

Default: Disabled

Level of system event that are sent from the 
OPC Server. Amount of events sent is 
cumulative, higher level also contains lower level 
events. System event level configuration at OPC 
Server level overrides definitions at subnetwork 
and device levels.

Each IEC 61850 node of the system must have a unique subnet / node address.

Table 1. IEC 61850 OPC Server Object Properties (Continued)

Name Value/Value Range Description
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Table 2. IEC 61850 Subnetwork Object Properties

Property Value / Value range Description

Basic

In Use In Use

Not In Use

Default: In Use

Controls whether the device communication

is initially in use or not.

Communication Port

IP Address 127.0.0.1 IP Address for communication channel. 
Dotted decimal to be used.

It is updated from scd file during import.
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IEC 61850 Device Object Properties

Table 3 lists the configurable properties for IEC 61850 Devices (used for ABB 
protection and control devices) and value ranges for these properties.

Communication Control

System Event Level Disabled

Level 1 (main operation and 
errors)

Level 2 (time synchronization 
errors)

Level 3 (time synchronization 
done)

Level 4 (reported local 
updates from devices)

Level 5 (reported 
unconfigured updates from 
devices)

Default: Disabled

Level of system events (OPC AE events) 
can be viewed with an OPC AE client or with 
a CET Diagnostic AE client for OPC Server. 
Amount of events sent is cumulative: higher 
level also contains lower level events. 
System event level configuration at 
subnetwork overrides definitions at device 
level. Same or higher event level must be set 
for Subnetwork as for IED.

System events can be used for debugging 
and event flow monitoring. Event level can 
be changed during the runtime by using the 
Diagnostic events level attribute, IEC 61850 
line attributes.

TCP/IP Keepalive 
Time-out

(1..3600)

Default: 15

TCP/IP Keepalive time-out in seconds.

Each IEC 61850 node of the system must have a unique subnet / node address.

Table 3. IEC 61850 Device Object Properties

Name Value / Value range Description

Basic

In Use In use

Not in use

Default: In use

Controls if the device communication is initially 
in use or not.

Table 2. IEC 61850 Subnetwork Object Properties (Continued)

Property Value / Value range Description
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Simulation Mode True

False

Default: False

Defines if the device is in simulation mode.

System Event Level Level0=Disabled

Level1=Level 1 
(main operation, 
error replies, errors)

Level2=Level 2 
(information reports, 
OK replies, RCB 
initializing)

Level3=Level 3 (sent 
requests (connect, 
read, write), 
transparent SPA 
messages)

Level4=Level 4 
(reported local 
updates)

Level5=Level 5 
(reported 
unconfigured 
updates)

Level of system events (OPC AE events) can 
be viewed with a CET Diagnostic AE client for 
OPC Server or with an OPC AE client. Amount 
of events sent is cumulative: higher level also 
contains lower level events. System event level 
configuration at subnetwork overrides 
definitions at device level. The same or higher 
event level must be set for Subnetwork as for 
IED.

System events can be used for debugging and 
event flow monitoring. Event level can be 
changed during the run time by using the 
Diagnostic events level attribute, IEC 61850 
device attributes.

Addresses

IP Address 127.0.0.1 IEC 61850 Node Number of the device. 

It is updated from scd file during import.

OSI ACSE AE Qualifier 23 IEC 61850 Subnet Number of the device.

OSI ACSE AP Title Value 1,3,9999,23 OSI ACSE AP Title Value as defined in IEC 
61850-8-1.

Table 3. IEC 61850 Device Object Properties (Continued)

Name Value / Value range Description
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OSI Presentation 
Selector

00000001 OSI Presentation Selector as defined in IEC 
61850-8-1.

OSI Session Selector 0001 OSI Session Selector as defined in IEC 61850-
8-1.

OSI Transport Selector 0001 OSI Transport Selector as defined in IEC 
61850-8-1.

Communication Control

Configuration Revision 
Check Enabled

True

False

Default: False

If enabled, checks configuration revisions from

all logical devices 
(LDx.LLN0.NamPlt.configRev).

If configuration revisions do not match between 
configuration and IED, communication to the 
IED is not established.

Dynamically Create Data 
Sets

True

False

Default: False

Specifies whether data sets and reporting are 
initialized dynamically.

Using static data sets is recommended. The 
IED needs to support this feature. If enabled, 
all configured data sets in CET are created and 
report control blocks configured at runtime to 
the IED after connecting. The dynamic data 
sets must be configured with the Dataset 
Editor and designated to available report 
control blocks. The report control blocks must 
be configured and dedicated for the IEC 61850 
OPC Server instance. Data sets used with 
buffered reporting are created once when the 
BRCB is first initialized. Data sets used with 
unbuffered reporting are created every time 
the URCB is initialized. Dynamic data sets are 
not removed.

Table 3. IEC 61850 Device Object Properties (Continued)

Name Value / Value range Description
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Enable EntryID Check True

False

Default: False

Enable reporting EntryID check. Report 
EntryIDs are used as sequence numbers for 
buffered reporting. A gap in sequence 
numbers will cause a restart of reporting, 
starting from lost sequence number.

MMS Request Timeout 0...60000

0 = disabled

Default: 5000

Specifies the timeout for the MMS request in 
milliseconds (msec). If 0 it is not in use.

Report Control Block 
Initialize

True

False

Default: True

Initialize to report control blocks and enable 
reporting.

Send Single Message 
MMS Writes

True

False

Default: False

Sends single message MMS writes.

Use 32 Bit Entry ID True

False

Default: False

Enables or disables usage of 32 bit EntryIDs 
for information report sequence. The IEC 
61850 standard defines 64 bit EntryID, but 
SPA-ZC 40x uses 32 bit EntryID.

Use Sequence Number 
Check

True

False

Default: False

Enables or disables sequence number 
checking information reports for the IEC 61850 
OPC server.

Table 3. IEC 61850 Device Object Properties (Continued)

Name Value / Value range Description



Section 2  800xA IEC61850 OPC Server IEC 61850 Device Object Properties

9ARD171387-510 D 39

Polling

Polling Timeout (0..3600)

Default: 0 (disabled)

Polling Timeout in seconds. If the device does 
not support reporting, ST and MX attributes 
can be polled with this interval.

Control Authorization

Disable Interlockcheck for 
All Controls

True

False

Default: False

Disables interlockcheck condition check for all 
select and operate controls.

Disable Synchrocheck for 
All Controls

True

False

Default: False

Disables synchrocheck condition check for all 
select and operate controls.

Interlock Override 
Supported

True

False

Default: False

Specifies whether Interlock Override is 
supported by this IED.

Station/Remote

Switch OPC Path

OPC path of the station remote switch position 
to be used with this device. 

The format is #ProgID For OPC 
Server#Channel Name\\IED Name\\Logical 
Device Name\\Logical Node Name\\Data 
Object Name. 

For example, 
#ABB.IEC61850_OPC_DA_Server.Instance[1]
1#Channel1\\IED1\\LD1\\GGIO1\\loc

Synchrocheck Override 
Supported

True

False

Default: False

Specifies whether Synchrocheck Override is 
supported by this IED.

OPC Alarm and Event

Area Name Specifies which area this IED belongs to.

Table 3. IEC 61850 Device Object Properties (Continued)

Name Value / Value range Description
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Area Description Description of area.

Device Connection Status 
Class

Default: Device 
Connection Status

Device Connection Status Class definition 
used with current device.

Measurement Limit 
Supervision

IED Based limit 
supervision

OPC Server based 
limit supervision

Specifies whether measurement limit 
supervision is performed by the IEC 61850 
OPC Server.

Authentication

Is Authentication 
Disabled

True 

False

Default: True

Is Authentication Disabled?

Is Password used True 

False

Default: False

Is Password used?

Password Default: None Password used for authentication.

SPA Access

SPA parameter for Close 
Password

SPA parameter for close Password.

SPA value for Open 
Password

SPA parameter value for open Password.

SPA Store parameter 
name

SPA store parameter name.

SPA Store parameter 
value

0...65536 SPA store parameter value.

SPA Value for Close 
Password

0...65536 SPA value for close password.

Table 3. IEC 61850 Device Object Properties (Continued)

Name Value / Value range Description
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SPA value for Open 
Password

0...65536 SPA value for open password.

Disturbance Recording

Disturbance Recorder 
Delete Recordings

Default: False Specifies whether DRs are deleted from IED 
after upload.

Disturbance Recorder 
Enabled

Default: False Specifies whether DR upload is enabled.

Disturbance Recorder 
Local Directory

Specifies the folder where all disturbance 
recordings will be stored in the running 
computer. If left empty 
"C:\COMTRADE\IEDName" will be used.

Disturbance Recorder 
Maximum Total File Size

0 - 2147483647

0: no limit

Default: 0

Specifies maximum size for folder where 
uploaded DRs are locally stored for this IED.

Disturbance Recorder 
Polling Period

0 - 2147483647

0: disabled

Default: 120

DR polling period in seconds

Disturbance Recorder 
Remote Directory

Specifies the folder where all disturbance 
recordings will be stored in this IED.

Disturbance Recording via FTP

Disturbance Recorder 
FTP Password

FTP password to be used with DR functionality

Disturbance Recorder 
FTP User Name

FTP username to be used with DR 
functionality

Disturbance Recorder 
Read Via FTP

False: MMS (IEC 
61850)

True: FTP

Default: False

Specifies whether DRs will be read using FTP

Table 3. IEC 61850 Device Object Properties (Continued)

Name Value / Value range Description
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Logical Device Object Properties

The logical devices are configured, whenever they are imported with IEC 61850 
Devices. Table 4 lists the configurable Logical Device object properties.

Web Server Enabled True

False

Default: False

Specifies whether IED Web Server is 
accessible from COM600 HMI.

Web Server IP Address IP Address for Web Server. Dotted decimal or 
DNS name to be used. If omitted and Web 
Server is enabled, IED IP address is used.

Table 4. Logical Device Object Properties

Name
Value / Value 

range
Description

Transparent SPA

SPA Address (0..999)

Default: 0

The SPA address of the device connected via TCP/IP.

By setting value >0 enables the built in TCP/SPA client, 
which can be used through the Transparent SPA attribute, 
IEC 61850 logical device attributes.

SPA TCP Port (1..65535) 

Default: 7001

SPA TCP Port.

SPA TCP 
Timeout

(1..65535)

Default: 3

SPA TCP Timeout in seconds.

Control Authorization

Table 3. IEC 61850 Device Object Properties (Continued)

Name Value / Value range Description
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Station/Remote 
Switch OPC Path

Station/Remote Switch OPC Path

OPC path of the station remote switch position to be used 
with this device. The format is Node#ProgID For OPC 
Server#Channel Name\IED Name\Logical Device 
Name\Logical Node Name\Data Object Name. For example, 
GW#ABB.IEC61850_OPC_DA_Server.Instance[1]#Channe
l1\IED1\LD1\GGIO1\loc.

SPA Access

SPA parameter 
for Close 
Password

SPA parameter for close Password.

SPA value for 
Open Password

SPA parameter value for open Password.

SPA Store 
parameter name

SPA store parameter name.

SPA Store 
parameter value

0...65536 SPA store parameter value.

SPA Value for 
Close Password

0...65536 SPA value for close password.

SPA value for 
Open Password

0...65536 SPA value for open password.

Table 4. Logical Device Object Properties (Continued)

Name
Value / Value 

range
Description
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Supported IEC 61850-Ed1 Data Objects

IEC 61850 OPC Server supports data objects for status, measurand, controllable 
status, and controllable analog information. The IEC 61850 OPC Server supports 28 
data object types for an IEC 61850 Device. The data objects are configured 
whenever they are imported with IEC 61850 devices. The configurations can be 
monitored with Data Object and Attribute Viewer on Page 45. 

Data classes for status information:

• Single point status (SPS)

• Double point status (DPS)

• Integer status (INS)

• Protection activation information (ACT)

• Directional protection activation information (ACD)

• Security violation counter (SEC)

• Binary counter reading (BCR)

Data classes for measurand information:

• Measured value (MV)

• Complex measured value (CMV)

• Sampled value (SAV)

• WYE

• Delta (DEL)

• Sequence (SEQ)

Data classes for controllable status information:

• Controllable single point (SPC)

• Controllable double point (DPC)

• Controllable integer status (INC)

• Binary controlled step position information (BSC)

• Integer controlled step position information (ISC)
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Data classes for controllable analog information:

• Analog set point (APC)

Data objects classes for status settings:

• Single setting point (SPG)

• Integer status setting (ING)

Data classes for analogue settings:

• Analogue setting (ASG)

• Setting curve (CURVE)

Data classes for description information:

• Device name plate (DPL)

• Logical Node name plate (LPL)

Data classes for internal status information:

• Integer status (Internal INS)

• Single point status (Internal SPS)

• Controllable single point (Internal SPC)

The parameters are stored in object properties in CET. The actual configuration for 
data objects is not supported.

Data Object and Attribute Viewer

The configured data object types, data attribute types and enumerated attributes can 
be viewed with the provided viewers for IEC 61850 OPC Server.

To view data object type viewer:

1. Right-click the IEC 61850 OPC Server.

2. Select DOType Viewer from the context menu.
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With DOType Viewer the attributes of the DOtypes can be viewed under the IEC 
61850 OPC Server in the communication structure. From the DOType drop-down 
menu, select the data object types to view.

To view data attribute type viewer:

1. Right-click the IEC 61850 OPC Server.

2. Select DAType Viewer from the context menu.

Figure 6. DOType Viewer
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With DAType Viewer, the attributes of the DAtypes can be viewed under the IEC 
61850 OPC Server in the communication structure. From the DAType drop-down 
menu, select the data attribute types to view.

To view enumerated basic type attributes:

1. Right-click the IEC 61850 OPC Server.

2. Select Enum Viewer from the context menu.

Figure 7. DAType Viewer
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With Enum Viewer, the enumeration of EnumTypes can be viewed under the IEC 
61850 OPC Server in the communication structure. From the EnumType drop-down 
menu, select the enumerated basic type attributes to view.

With DOI Editor, the data object’s default values are overridden if necessary. Refer 
to IEC standards IEC 61850-6 and IEC 61850-7-3.

Measurement

Measurement Limit Supervision

Configuring OPC Server based measurement limit supervision and units:

Measurement limit value supervision is done by the IEC 61850 IED with the 
specified LNs. If the IED does not support limit value supervision or does not 
provide units for the measurements, it is possible to configure the OPC server 
instead to handle the limit value supervision and to publish units for the 
measurements to realize a common IEC 61850 substation supervision functionality 
for the 800xA operator workplaces. Supervision mode (IED or OPC) can be 

Figure 8. Enum Viewer
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configured with the Measurement Limit Supervision property of the IEC61850 
device for each IED. If the IED based supervision mode is selected, the limit values 
can be configured with the properties described in the following sections.

The data objects MV, CMV, SEQ, DEL and WYE support measurement limit 
supervision. MV, CMV, SAV, SEQ, DEL and WYE measurement data objects 
support overriding unit and multiplier information. The configurable properties for 
the data objects are presented in the following sections.

Common Data Class Object Properties

MV, CMV, DEL Properties

Table 5 Configurable limit supervision properties for the MV, CMV DEL object. 

Table 5. Configuring MV, CMV, DEL properties

Property Type

[060] Limit Value Supervision

Max float

High-High float

High float

Low float

Low-Low float

Min float

[050] Scale and Unit

Multiplier Enum

Scale Enum

SI Unit Enum
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SAV Properties

Table 6 Configurable limit supervision properties for the SAV object. 

SEQ Properties

Table 7 Configurable limit supervision properties for the SEQ object. 

Table 6. Configuring SAV properties

Property Type

[050] Scale and Unit

SI Unit Enum

Multiplier Enum

Table 7. Configuring SEQ properties

Property Type

 [060] C1 Limit Value Supervision

Max float

High-High float

High float

Low float

Low-Low float

Min float

[060] C2 Limit Value Supervision

Max float

High-High float

High float

Low float

Low-Low float
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WYE Properties

Table 8 Configurable limit supervision properties for the WYE object. 

Min float

[060] C3 Limit Value Supervision

Max float

High-High float

High float

Low float

Low-Low float

Min float

[050] Scale and Unit

C1 Multiplier Enum

C1 SI Unit Enum

C2 Multiplier Enum

C2 SI Unit Enum

C3 Multiplier Enum

C3 SI Unit Enum

Table 8. Configuring SEQ properties

Property Type

 [060] Phase Limit Value Supervision

Max float

High-High float

Table 7. Configuring SEQ properties

Property Type
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High float

Low float

Low-Low float

Min float

[060] Net Limit Value Supervision

Max float

High-High float

High float

Low float

Low-Low float

Min float

[060] Neutral Limit Value Supervision

Max float

High-High float

High float

Low float

Low-Low float

Min float

[060] Res Limit Value Supervision

Max float

High-High float

High float

Low float

Table 8. Configuring SEQ properties

Property Type
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Other Common Data Class Object Properties

Common Data Class Specifications for Status Information

Single Point Status (SPS)

Table 9 defines the common data class of single point status. 

Low-Low float

Min float

[050] Scale and Unit

Net Multiplier Enum

Net SI Unit Enum

Neut Multiplier Enum

Neut SI Unit Enum

Phase Multiplier Enum

Phase SI Unit Enum

Res Multiplier Enum

Res SI Unit Enum

Table 9. Single Point Status

Name Type FC
Value/Value 

range
M/O/C 

OPC Data
Type

stVal BOOLEAN ST TRUE

FALSE

M VT_BOOL

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

Table 8. Configuring SEQ properties

Property Type
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Double Point Status (DPS)

Table 10 defines the common data class of double point status.

subEna BOOLEAN SV O VT_BOOL

subVal BOOLEAN SV TRUE

FALSE

O VT_BOOL

subQ Quality SV O VT_I4

subID VISIBLE

STRING64

SV O VT_BSTR

d VISIBLE

STRING64

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs UNICODE

STRING255

EX O VT_BSTR

cdcName UNICODE

STRING255

EX O VT_BSTR

dataNs UNICODE

STRING255

EX O VT_BSTR

Table 9. Single Point Status (Continued)

Name Type FC
Value/Value 

range
M/O/C 

OPC Data
Type
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Table 10. Double Point Status

Name Type FC Value/Value range M/O 
OPC Data

Type

stVal CODED

ENUM

ST intermediatestate (0)

off (1)

on (2)

bad-state (3)

M VT_I4

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

subEna BOOLEAN SV O VT_BOOL

subVal CODED

ENUM

SV intermediatestate (0)

off (1)

on (2)

bad-state (3)

O VT_I4

subQ Quality SV O VT_I4

subID VISIBLE

STRING64

SV O VT_BSTR

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR
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Integer Status (INS)

Table 11 defines the common data class of Integer status. 

Protection Activation information (ACT)

Table 11. Integer Status

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type

stVal INT32 ST M VT_I4

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

subEna BOOLEAN SV O VT_BOOL

subVal INT32 SV O VT_I4

subQ Quality SV O VT_I4

subID VISIBLE

STRING64

SV O VT_BSTR

d VISIBLE

STRING255

DC O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR
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Table 12 defines the common data class of protection activation information. 

Directional Protection Activation Information (ACD)

Table 12. Protection Activation Information

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type

general BOOLEAN ST M VT_BOOL

phsA BOOLEAN ST O VT_BOOL

phsB BOOLEAN ST O VT_BOOL

phsC BOOLEAN ST O VT_BOOL

neut BOOLEAN ST O VT_BOOL

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

operTm TimeStamp CF O VT_DATE

d VISIBLE

STRING255

DC O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR
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Table 13 defines the common data class of Directional protection activation 
information. 

Table 13. Directional Protection Activation Information

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type

general BOOLEAN ST M VT_BOOL

dirGeneral ENUMERATED ST unknown (3)

forward (1)

backward (2)

M

phsA BOOLEAN ST O VT_BOOL

dirPhsA ENUMERATED ST unknown (3)

forward (1)

backward (2)

O

phsB BOOLEAN ST O VT_BOOL

dirPhsB ENUMERATED ST unknown (3)

forward (1)

backward (2)

O

phsC BOOLEAN ST O VT_BOOL

dirPhsC ENUMERATED ST unknown (3)

forward (1)

backward (2)

neut BOOLEAN ST O VT_BOOL

dirNeut ENUMERATED ST unknown (3)

forward (1)

backward (2)

O

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE
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Security Violation Counter (SEC)

Table 14 defines the common data class of Security violation counting 
information.

d VISIBLE

STRING255

DC O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 14. Security Violation Counting

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type

cnt INT32U ST M VT_I4

sev ENUMERATED ST unknown (0)

critical (1)

major (2)

minor (3)

warning (4)

M VT_I4

t TimeStamp ST M VT_DATE

Table 13. Directional Protection Activation Information (Continued)

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type
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Binary Counter Reading (BCR)

Table 15 defines the common data class of binary counter reading information.

addr OCTET

STRING64

ST O VT_BSTR

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 15. Binary Counter Reading

Name Type FC
Value/Value 

range
M/O 

OPC Data
Types

actVal INT128 ST M VT_I4

frVal INT128 ST O(1) VT_I4

frTm TimeStamp ST O(1) VT_DATE

q Quality ST M VT_I4

t TimeStamp ST VT_DATE

units Unit CF O VT_R4

Table 14. Security Violation Counting (Continued)

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type



Section 2  800xA IEC61850 OPC Server Measurement

9ARD171387-510 D 61

Common Data Class Specifications for Controllable Status Information

Controllable Single Point (SPC)

Table 16 defines the common data class of controllable single point.

pulsQty FLOAT32 CF M VT_BOOL

frEna BOOLEAN CF O(1) VT_DATE

strTm TimeStamp CF O(1) VT_DATE

frPd INT32 CF O(1) VT_BOOL

frRds BOOLEAN CF O(1) VT_BSTR

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

(1) All or none of these items must be present.

Table 15. Binary Counter Reading (Continued)

Name Type FC
Value/Value 

range
M/O 

OPC Data
Types
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Table 16. Controllable Single Point

Name Type FC Value/Value range M/O 
OPC Data

Type

lastApplError ApplicationError
Code

MX Refer to Application 
Error Codes on 
Page 297

O(a) VT_I4

ctlVal BOOLEAN CO off (FALSE)

on (TRUE)

M VT_BOOL

operTm TimeStamp CO O VT_DATE

origin Originator CO, ST

ctlNum INT8U CO, ST 0..255 O VT_I4

stVal BOOLEAN ST FALSE

TRUE

M VT_BOOL

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

stSeld BOOLEAN ST FALSE

TRUE

O VT_BOOL

subEna BOOLEAN SV O VT_BOOL

subVal BOOLEAN SV FALSE

TRUE

O VT_BOOL

subQ Quality SV O VT_I4

subID VISIBLE

STRIN64

SV O VT_BSTR

pulseConfig PulseConfig CF O
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Mapping of controls

• Direct Control with Normal Security:
ctlVal: MMS Write.request to Oper structure with value.

ctlModel ENUMERATED CF Status-only (0)

directwithnormalsec
urity (1)

sbowithnormalsecur
ity (2) 
directwithenhanced
security(3)

sbowithenhancedse
curity(4)

M VT_I4

sboTimeout INT32U CF O VT_I4

sboClass ENUMERATED CF operate-once (0) 
operatemany (1)

O VT_I4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 16. Controllable Single Point

Name Type FC Value/Value range M/O 
OPC Data

Type
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• SBO with Normal Security:
ctlVal: MMS Write.request to ctlVal with value. IEC61850 OPC Server will do 
the select before operate.

• Direct Control with Enhanced Security:
tlVal: MMS Write.request to Oper structure with value.

• SBO with Enhanced Security:
ctlVal: MMS Write.request to ctlVal with value. IEC61850 OPC Server will do 
the select before operate.

Controllable Double Point (DPC)

Table 17 defines the common data class of controllable double point. 

Table 17. Controllable Double Point

Name Type FC Value/Value range M/O 
OPC Data

Type

ctlSelOn AbbCommand
Bitmask

M VT_I4

ctlSelOff AbbCommand
Bitmask

M VT_I4

ctlOperOn AbbCommand
Bitmask

M VT_I4

ctlOperOff AbbCommand
Bitmask

M VT_I4

ctlCan AbbCommand
Bitmask

M VT_I4

ctlOper AbbCommand
Bitmask

M VT_I4

lastApplErr
or

ApplicationErro
rCode

Refer to Application Error 
Codes on Page 297

M VT_I4

ctlVal BOOLEAN CO off (FALSE)

on (TRUE)

M VT_BOOL



Section 2  800xA IEC61850 OPC Server Measurement

9ARD171387-510 D 65

operTm TimeStamp CO O VT_DATE

origin Originator CO, ST

ctlNum INT8U CO, ST 0..255 O VT_I4

stVal CODED

ENUM

ST intermediatestate(0) 

off (1)

on (2)

bad-state (3)

M VT_I1

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

stSeld BOOLEAN ST FALSE

TRUE

O VT_BOOL

subEna BOOLEAN SV O VT_BOOL

subVal BOOLEAN SV intermediatestate(0) 

off (1)

on (2)

bad-state (3)

O VT_I1

subQ Quality SV O VT_I4

subID VISIBLE

STRIN64

SV O VT_BSTR

pulseConfig PulseConfig CF O

ctlModel ENUMERATED CF Status-only (0)

directwithnormalsecurity (1)

sbowithnormalsecurity (2) 
directwithenhancedsecurity(3)

sbowithenhancedsecurity(4)

M VT_I4

Table 17. Controllable Double Point

Name Type FC Value/Value range M/O 
OPC Data

Type
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• ctlOperOn: This attribute determines the control activity operation in direction 
On/Close.

• ctlOperOff: This attribute determines the control activity operation in 
direction Off/Open.

• ctlSelOn: This attribute determines the selection with direction On/Close.

• ctlSelOff; This attribute determines the selection with direction Off/Open.

• ctlCan: This attribute determines the cancellation of the selection

• ctlOper: This attribute determines the selection with direction

Mapping of controls

• Direct Control with Normal Security:

– ctlSelOn: (not used)

sboTimeout INT32U CF O VT_I4

sboClass ENUMERATED CF operate-once (0) 

operatemany (1)

O VT_I4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 17. Controllable Double Point

Name Type FC Value/Value range M/O 
OPC Data

Type
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– ctlSelOff: (not used)

– ctlOperOn: MS Write.request to Oper structure with value ON.

– ctlOperOff: MMS Write.request to Oper structure with value OFF.

– ctlCan: (not used)

– ctlOper: (not used)

The ctlSelOn, ctlSelOff, ctlCan, selCause, cmdTermCause, stSeld and the bits in 
ControlValues are not applicable.

• SBO with Normal Security:

– ctlSelOn: MMS Read.request to SBO structure (to perform select).

– ctlSelOff: MMS Read.request to SBO structure (to perform select).

– ctlOperOn: MMS Write.request to Oper structure with value ON (to 
operate).

– ctlOperOff: MMS Write.request to Oper structure with value OFF (to 
operate).

– ctlCan: MMS Write.request ro Cancel structure

– ctlOper: MMS Write.request to Oper structure with value ON/OFF 
according to previous direction of select.

• Direct Control with Enhanced Security:

– ctlSelOn: (not used)

– ctlSelOff: (not used)

– ctlOperOn: MMS Write.request to Oper structure with value ON.

– ctlOperOff: MMS Write.request to Oper structure with value OFF.

– ctlCan: MMS Write.request ro Cancel structure

– ctlOper: (not used)

• SBO with Enhanced Security:

– ctlSelOn: MMS Read.request to SBOw structure.

– ctlSelOff: MMS Read.request to SBOw structure.
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– ctlOperOn: MMS Write.request to Oper structure with value ON.

– ctlOperOff: MMS Write.request to Oper structure with value OFF.

– ctlCan: MMS Write.request to Cancel structure

– ctlOper: MMS Write.request to Oper structure with value ON/OFF 
according to previous direction of select.

Controllable Integer Status (INC)

Table 18 defines the common data class of controllable integer status. 

Table 18. controllable integer status

Name Type FC Value/Value range M/O 
OPC Data

Type

lastApplError ApplicationErro
rCode

Refer to Application Error 
Codes on Page 297

VT_I4

ctlVal INT32 CO M VT_I4

operTm TimeStamp CO O VT_DAT

orCat ENUMERATED O VT_I4

orIdent OCTET

STRING64

O VT_BSTR

ctlNum INT8U CO, ST 0..255 O VT_I4

stVal INT32 ST M VT_I4

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

stSeld BOOLEAN ST FALSE

TRUE

O VT_BOOL

subEna BOOLEAN SV O VT_BOOL

subVal INT32 SV O VT_I4

subQ Quality SV O VT_I4
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Mapping of controls

• Direct Control with Normal Security:

subID VISIBLE

STRING64

SV Text O VT_BSTR

ctlModel ENUMERATED CF Status-only (0)

directwithnormalsecurity (1)

sbowithnormalsecurity (2) 
directwithenhancedsecurity(3)

sbowithenhancedsecurity(4)

M VT_I4

sboTimeout INT32U CF O VT_I4

sboClass ENUMERATED CF operate-once (0) 

operatemany (1)

O VT_I4

minVal INT32 CF O VT_I4

maxVal INT32 CF O VT_I4

stepSize INT32U CF 1 ... (maxVal - minVal) O VT_I4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 18. controllable integer status

Name Type FC Value/Value range M/O 
OPC Data

Type
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– ctlVal: MMS Write.request to Oper structure with value.

• SBO with Normal Security:

– ctlVal: MMS Write.request to Oper structure with value. IEC61850 OPC 
Server will do the select before operate.

• Direct Control with Enhanced Security:

– ctlVal: MMS Write.request to Oper structure with value.

• SBO with Enhanced Security:

– ctlVal: MMS Write.request to Oper structure with value. IEC61850 OPC 
Server will do the select before operate.

Binary Controlled Step Position Information (BSC)

Table 19 defines the common data class of binary controlled step position 
information. 

Table 19. Binary Controlled Step Position Information

Name Type FC Value/Value range M/O 
OPC Data

Type

lastApplErr
or

ApplicationErro
rCode

Refer to Application Error 
Codes on Page 297

VT_I4

ctlVal ENUMERATED stop (0) 

lower (1) 

higher (2)

reserved (3)

M VT_I4

operTm TimeStamp CO O VT_DAT
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orCat ENUMERATED not-supported

bay-control 

station-control

remote-control

automatic bay 

automatic-station

automaticremote 

maintenance 

process

O VT_I4

orIdent OCTET

STRING64

O VT_BSTR

ctlNum INT8U CO, 
ST

0..255 O VT_I4

valWTr.pos
Val

INT8 ST M VT_I4

valWTr.tran
sInd

BOOLEAN ST M VT_BOOL

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

stSeld BOOLEAN ST FALSE

TRUE

O VT_I4

q Quality ST M VT_BOOL

t TimeStamp ST M VT_DATE

stSeld BOOLEAN ST FALSE

TRUE

O VT_BOOL

subEna BOOLEAN SV O VT_BOOL

Table 19. Binary Controlled Step Position Information

Name Type FC Value/Value range M/O 
OPC Data

Type



Measurement Section 2  800xA IEC61850 OPC Server

72 9ARD171387-510 D

subVal INT32 SV O VT_I4

subQ Quality SV O VT_I4

subID VISIBLE

STRING64

SV Text O VT_BSTR

ctlModel ENUMERATED CF Status-only (0)

directwithnormalsecurity (1)

sbowithnormalsecurity (2) 
directwithenhancedsecurity(3)

sbowithenhancedsecurity(4)

M VT_I4

sboTimeout INT32U CF O VT_I4

sboClass ENUMERATED CF operate-once (0) 

operatemany (1)

O VT_I4

minVal INT8 CF O VT_I4

maxVal INT8 CF O VT_I4

stepSize INT8 CF 1 ... (maxVal - minVal) O VT_I4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 19. Binary Controlled Step Position Information

Name Type FC Value/Value range M/O 
OPC Data

Type
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Mapping of controls

• Direct Control with Normal Security:

– ctlVal: MMS Write.request to Oper structure with value.

• SBO with Normal Security:

– ctlVal: MMS Write.request to Oper structure with value.

– IEC61850 OPC Server will do the select before operate.

• Direct Control with Enhanced Security:

– ctlVal: MMS Write.request to Oper structure with value.

• SBO with Enhanced Security:

– ctlVal: MMS Write.request to Oper structure with value.

– IEC61850 OPC Server will do the select before operate.

Integer Controlled Step Position Information (ISC)

Table 20 defines the common data class of integer controlled step position 
information. 

Table 20. Integer Controlled Step Position Information

Name Type FC Value/Value range M/O 
OPC Data

Type

lastApplError ApplicationErro
rCode

Refer to Application Error 
Codes on Page 297

VT_I4

ctlVal INT8 CO -64 … 63 M VT_I4

operTm TimeStamp CO O VT_DAT
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orCat ENUMERATED not-supported

bay-control 

station-control

remote-control

automatic bay 

automatic-station

automaticremote 

maintenance 

process

O VT_I4

orIdent OCTET

STRING64

O VT_BSTR

ctlNum INT8U CO, ST 0..255 O VT_I4

valWTr.posV
al

INT8 ST M VT_I4

valWTr.transI
nd

BOOLEAN ST M VT_BOOL

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

stSeld BOOLEAN ST FALSE

TRUE

O VT_I4

subEna BOOLEAN SV O VT_BOOL

subVal INT32 SV O VT_I4

subQ Quality SV O VT_I4

subID VISIBLE

STRING

SV Text O VT_BSTR

Table 20. Integer Controlled Step Position Information

Name Type FC Value/Value range M/O 
OPC Data

Type
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Mapping of controls

• Direct Control with Normal Security:

– ctlVal: MMS Write.request to Oper structure with value.

ctlModel ENUMERATED CF Status-only (0)

directwithnormalsecurity (1)

sbowithnormalsecurity (2) 
directwithenhancedsecurity(3)

sbowithenhancedsecurity(4)

M VT_I4

sboTimeout INT32U CF O VT_I4

sboClass ENUMERATED CF operate-once (0) 

operatemany (1)

O VT_I4

minVal INT8 CF O VT_I4

maxVal INT8 CF O VT_I4

stepSize INT8 CF 1 ... (maxVal - minVal) O VT_I4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 20. Integer Controlled Step Position Information

Name Type FC Value/Value range M/O 
OPC Data

Type



Measurement Section 2  800xA IEC61850 OPC Server

76 9ARD171387-510 D

• SBO with Normal Security:

– ctlVal: MMS Write.request to Oper structure with value.

– IEC61850 OPC Server will do the select before operate.

• Direct Control with Enhanced Security:

– ctlVal: MMS Write.request to Oper structure with value.

• SBO with Enhanced Security:

– ctlVal: MMS Write.request to Oper structure with value.

– IEC 61850 OPC Server will do the select before operate.

Common Data Class Specifications for Controllable Analogue Information

Analogue Set Point (APC)

Table 21 defines the common data class of analogue set point. 

Table 21. Analogue Set Point

Name Type FC Value/Value range M/O 
OPC Data

Type

lastApplError ApplicationErro
rCode

Refer to Application Error 
Codes on Page 297

VT_I4

setMag AnalogueValue SP, MX M VT_R4

origin Originator SP, MX O

operTm TimeStamp SP O VT_DAT

q Quality ST M VT_I4

t TimeStamp ST M VT_DATE

ctlModel ENUMERATED CF direct-with-normal-security (1) M VT_I4

units Unit CF O

sVC ScaledValueCo
nfig

CF O

minVal AnalogueValue CF O VT_R4
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Mapping of controls

• Direct Control with Normal Security:

– setMag: MMS Write.request to Oper structure with value.

• SBO with Normal Security:

– setMag: MMS Write.request to Oper structure with value. IEC61850 OPC 
Server will do the select before operate.

• Direct Control with Enhanced Security:

– setMag: MMS Write.request to Oper structure with value.

• SBO with Enhanced Security:

– setMag: MMS Write.request to Oper structure with value. IEC61850 OPC 
Server will do the select before operate.

maxVal AnalogueValue CF O VT_R4

stepSize AnalogueValue CF 1 ... (maxVal - minVal) O VT_R4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 21. Analogue Set Point (Continued)

Name Type FC Value/Value range M/O 
OPC Data

Type
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Common Data Class Specifications for Status Settings

Single Point Setting (SPG)

Table 22 defines the common data class of single point setting. 

Integer Status Setting (ING)

Table 23 defines the common data class of integer status setting. 

Table 22. Single Point Setting

Name Type FC Value/Value range M/O 
OPC Data

Type

setVal BOOLEAN SP off (FALSE)

on (TRUE)

M VT_BOOL

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 23. Integer Status Setting

Name Type FC Value/Value range M/O 
OPC Data

Type

setVal INT32 SP M VT_I4

minVal INT32 CF O VT_I4

maxVal INT32 CF O VT_I4
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Common Data Class Specifications for Analogue Settings

Analogue Setting (ASG)

Table 24 defines the common data class of analogue setting. 

stepSize INT32 CF 1 ... (maxVal - minVal) O VT_I4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 24. Analogue Setting

Name Type FC Value/Value range M/O 
OPC Data

Type

setMag AnalogueValue SP, MX M VT_I4

units Unit CF O

sVC ScaledValueCo
nfig

CF O

minVal AnalogueValue CF O VT_I4

maxVal AnalogueValue CF O VT_I4

Table 23. Integer Status Setting (Continued)

Name Type FC Value/Value range M/O 
OPC Data

Type
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Setting Curve (CURVE)

Table 25 defines the common data class of Setting curve. 

stepSize AnalogueValue CF 1 ... (maxVal - minVal) O VT_I4

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 25. Setting Curve

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type

setCharact ENUMERATED SP M VT_I4

setParA FLOAT32 SP O VT_R4

setParB FLOAT32 SP O VT_R4

setParC FLOAT32 SP O VT_I4

setParD FLOAT32 SP O VT_I4

setParE FLOAT32 SP O VT_I4

setParF FLOAT32 SP O VT_I4

Table 24. Analogue Setting (Continued)

Name Type FC Value/Value range M/O 
OPC Data

Type
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Common Data Class Specifications for Description Information

Device Name Plate (DPL)

Table 26 defines the common data class of device name plate. Data of this 
common data class are used to identify entities like primary equipment or 
physical devices.

d VISIBLE

STRING255

DC Text O VT_BSTR

dU UNICODE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 26. Device Name Plate

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type

vendor VISIBLE

STRING255

DC M VT_BSTR

hwRev VISIBLE

STRING255

DC O VT_BSTR

swRev VISIBLE

STRING255

DC O VT_BSTR

Table 25. Setting Curve (Continued)

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type
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Logical Node Name Plate (LPL)

Table 27 defines the common data class of logical node name plate. Data of this 
common data class are used to identify logical nodes.

serNum VISIBLE

STRING255

DC O VT_BSTR

model VISIBLE

STRING255

DC O VT_BSTR

location VISIBLE

STRING255

DC O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 27. Logical Node Name Plate

Name Type FC Value/Value range M/O 
OPC Data

Type

vendor VISIBLE

STRING255

DC M VT_BSTR

hwRev VISIBLE

STRING255

DC M VT_BSTR

d VISIBLE

STRING255

DC Text M VT_BSTR

Table 26. Device Name Plate

Name Type FC
Value/Value 

range
M/O 

OPC Data
Type
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Report Control Block Object Properties

Data Sets

A data set is an ordered group of data objects and data attributes organized as a 
single collection for the convenience of the client. Data sets are used to define the 
values of data to be transmitted in case a value of a data set member changes. A data 
set is used for data reporting and GOOSE messaging.

Data Reporting

Data changes are used as a trigger for reporting. This information is grouped using a 
data set. The data set is the content basis for reporting. Reporting uses information 

dU VISIBLE

STRING255

DC O VT_BSTR

configRev VISIBLE

STRING255

DC O VT_BSTR

ldNs VISIBLE

STRING255

EX will be included only

in LLN0

O VT_BSTR

lnNs VISIBLE

STRING255

EX O VT_BSTR

cdcNs VISIBLE

STRING255

EX O VT_BSTR

cdcName VISIBLE

STRING255

EX O VT_BSTR

dataNs VISIBLE

STRING255

EX O VT_BSTR

Table 27. Logical Node Name Plate

Name Type FC Value/Value range M/O 
OPC Data

Type
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reports to transmit data. The data configured in a data set is transmitted in 
information reports. Reporting is controlled by report control blocks.

Report Control Block

Report control describes the conditions for generating information reports based on 
parameters set by configuration or by a client. Report Control Blocks control the 
procedures that are required for reporting values of data from logical nodes to one 
client.

There are buffered and unbuffered report control blocks:

• In a Buffered Report Control Block (BRCB) internal events issue immediate 
sending of reports, or buffer the events for transmission. This way the values of 
a data object are not lost due to transport flow control constraints or loss of 
connection. BRCB provides sequence-of-events functionality.

• In an Unbuffered Report Control Block (URCB) internal events issue 
immediate sending of reports on a best efforts basis. If no association exists, or 
if the transport data flow is not fast enough to support it, events may be lost.

Table 28. Report Control Block object properties

Property Value / Value range Description

Basic

Buffer Time Default: 0 milliseconds With this value, RCB can be configured to 
wait for other events after the first change 
before sending the report. Value 0 means 
that a new change is immediately 
reported to the client. Configurable.

Buffered True

False

Default: True

Controls if the RCB is buffered or 
unbuffered

Configuration 
Revision

0...2147483647 Configuration revision of the data set 
referenced by this RCB. Every 
modification in the data set increases the 
Configuration Revision property by one.
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Data Set The name of the data set to be sent by the 
report control block.

Indexed True

False

Default: True

Indicates if this RCB is configured with 
indexed naming convention.

Integrity 
period

0...214748647

Default: 0

Integrity period in milliseconds. If this 
attribute has a value > 0 ms, an integrity 
report with all data listed in the data set is 
sent periodically in this interval. By 
default, this feature is not enabled, 
because it generates an unnecessary 
load to the server and network. If this 
feature is used, the Trigger Option ‘Period’ 
in RCB needs to be enabled. Configurable

Report ID Used as identification in information 
reports to specify that the report is from 
this RCB. By default report control block 
MMS path name is used. Configurable.

Option Fields Defines what information is sent with the 
information report. Configurable.

Config 
Reference

True 

False

Default: False

Config Reference

Data Ref True 

False

Default: False

Data Ref

Data Set True 

False

Default: False

Data Set

Table 28. Report Control Block object properties (Continued)

Property Value / Value range Description
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Entry ID True 

False

Default: True

Entry ID

Reason Code True 

False

Default: True

Reason Code

Sequence 
Number

True 

False

Default: True

Sequence Number

Time Stamp True 

False

Default: False

Time Stamp

Trigger 
Options

Defines the triggering conditions for 
creating reports.

Data change True

False

Default: True

Specifies whether a report entry will be 
generated due to a change of the value of 
the data attribute.

Data Update True

False

Default: False

Specifies whether a report entry will be 
generated due to freezing the value of an 
unfreezable attribute or updating the 
value of any other attribute. An updated 
value may have the same value as the old 
value.

Table 28. Report Control Block object properties (Continued)

Property Value / Value range Description
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Period True

False

Default: False

Specifies whether a report entry will be 
generated on the expiration of the integrity 
period.

Quality 
Change

True

False

Default: True

Specifies whether a report entry will be 
generated due to a change of the value of 
the quality attribute.

Table 28. Report Control Block object properties (Continued)

Property Value / Value range Description
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CET Project Configuration
A new CET project is created to configure the IEC 61850 OPC Server. Perform the 
following steps to create CET project and configure the IEC 61850 OPC Server:

1. Double-click the CET icon on the desktop or select Start > ABB > IEC61850 
OPC Server > Communication Engineering Tool.

2. In File menu, select File > Open/Manage Project.

3. In the Open/Manage Project dialog box, click New Project.  

Figure 9. Open/Manage Project in CET

Figure 10. Open/Manage Project Dialog Box
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4. In the New Project dialog box, enter the Project name and the Description.

Adding Computer Node Object

5. Select the newly created project.

Figure 11. New Project Dialog Box

If the user want to open an existing project, in Step 3, locate the project in 
currently available projects list and click Open Project.
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6. Right-click new project name and select New > Communication > Computer 
Node. Figure 12 shows the new Computer Node created in the Communication 
structure.

Adding OPC Server Object

7. Right-click Computer Node object and select New > IEC61850 > IEC61850 
OPC Server.

Figure 12. Computer Node Selection

Figure 13. OPC Server Selection
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8. Right-click OPC Server instance and select Properties. 

9. In the right-side pane, under Basic:

a. For AE ProgID, 

enter ABB.IEC61850_OPC_AE_Server.Instance[n], where n is OPC 
Server instance number and n=1,2,3,4,……32.

b. For DA ProgID, 

enter ABB.IEC61850_OPC_DA_Server.Instance[n], where n is OPC 
Server instance number and n=1,2,3,4,……32. 

c. For Instance Number, enter n, where n is same as mentioned in Step a 
and Step b.      

Figure 14. Properties Selection

Figure 15. Basic
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Ensure that in Step a, Step b and Step c, n must be the same. For example, if n=1 
for step a, then n=1 for steps b and c respectively.

Ensure that the OPC Server Instance number running on Connectivity Server is 
unique across the 800xA System. Exception to this is if redundancy pair exists.

AE ProgID, DA ProgID and Instance Number for the first connectivity server 
are created automatically on selecting Update and Reload configuration. 
However, note that the OPC Server instance number starts from one and in 
sequence for each Connectivity Server. 

Table 29 illustrates the instance number for each Connectivity Servers. Automatic 
creation of instance number is recommended only for the first connectivity server 
and its redundant pair if exists. 

Table 29. OPC Server Instance Numbering

800xA Connectivity 
Server

OPC Server OPC Server - Redundant

1 - Redundant 1,2,3,4 1,2,3,4 

2 - Non Redundant 5,6,7,8 -

3 - Non Redundant 9,10,11,12 -

4 - Redundant 13,14,15,16 13,14,15,16

5 - Redundant 17, 18,19,20 17, 18,19,20

6 - Non Redundant 21,22,23,24 -

7 - Redundant 25,26,27,28 25,26,27,28

8 - Non Redundant 29,30,31,32 -

Once the OPC Server instance is created, it is recommended not to change the AE 
ProgID, the DA ProgID, and the Instance Number.
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SCL Import 

After adding an IEC 61850 OPC Server object, perform the following steps to 
import the scd file:

1. Select an IEC 61850 OPC Server instance that needs to be configured.

2. Right-click IEC 61850 OPC Server object and select SCL Import.

Figure 16. SCL Import Selection
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3. Click Choose File.

4. Browse and select the required SCD File in the file browser dialog and click 
Open.

Figure 17. Choose File

Figure 18. Choose SCL File Dialog Box
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5. Select the OPC Server (Substation) that points to the subnetwork from the 
Selected OPC Server drop-down and click Import.  

Figure 19. Subnetwork Selection
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Table 30 provides descriptions on the SCL Import screen:   

Table 30. Subnetwork selection field details

Subnetwork Field Labels Description

Filter DOs that don’t belong to the 
DataSet:

Enhance the performance by selecting this option, as 
it limits the amount of data objects being imported. If 
a data object does not belong to any data set, it will 
not be imported. Some IEDs can provide large 
amounts of data that is not reported, that is, not 
updated in COM600 HMI.

Overwrite existing descriptions All existing descriptions of objects affected by the 
import operation are overwritten. Select this option 
only if you know that the file to be imported contains 
better descriptions than your current configuration.

Import protocol configuration (sAddr) Both the object tree and protocol configuration are 
created. If you do not select this option, only the 
object tree structure is created.

While re-importing the SCD, the checkbox Import 
Protocol Configuration (sAddr) must be cleared to 
avoid overwriting of the existing event definition 
mappings of Data objects in the CET project.

Overwrite Alarm and Event settings All configured alarm and event settings are 
overwritten and the default settings are assigned to 
them. 

 Select this option only if customized Alarm and 
Event settings is available on the existing 
configuration.

Overwrite Limit settings All configured unit and limit configurations are 
overwritten and the values from the SCL file are 
assigned to them.

Do not import DO's without protocol 
configuration (sAddr)

None of the data objects without communication 
information are created to the object tree.
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6. The SCD file contents is populated into CET as shown in Figure 20. 

Check RCBs for Client Identity IEDs are imported from the given file in which the 
client identity of the Report Control Blocks matches 
the selected OPC Server.

Check Configuration Revisions Configuration revision attributes of the project are 
compared to the SCL file to be imported.

Figure 20. CET Project Explorer

Table 30. Subnetwork selection field details (Continued)

Subnetwork Field Labels Description
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Table 31. SCD File Information for IEC 61850 OPC Server

SCD File Information Description

Communication Section

Subnetwork

(Name, IP address)

The Name, IP address field of subnetwork 
used from SCD file by IEC 61850 OPC 
Server.

For more information, refer to IEC 61850 
Subnetwork Object Properties on Page 33.

IED Section

(Name, Type, IP address, 
Manufacturer, configVersion, OSI-
AP-Title, OSI-AE-Qualifier, OSI-
TSEL, OSI-PSEL, OSI-SSEL)

The Name, Type, IP address, Manufacturer, 
configVersion, OSI-AP-Title, OSI-AE-
Qualifier, OSI-TSEL, OSI-PSEL, OSI-SSEL 
field of IED used from SCD file by IEC61850 
OPC server.

For more information, refer to IEC 61850 
Device Object Properties on Page 35.

Logical Device under IED>LD 
(Name)

The Name field of Logical Device used from 
SCD file by IEC61850 OPC server. 

For more information, refer to Logical Device 
Object Properties on Page 42.

Logical Node under IED>LD>LN.

(Name, lnClass, lnInst, prefix, cdc, 
DOI name, DAI name)

The 
Name,lnclass,lninst,prefix,cdc,DOIName,DAI
Name field of Logical Node used from SCD 
file by IEC61850 OPC Server.

Report Control Block under 
IED>LD0.

The RCB field is used from SCD file by 
IEC61850 OPC server. 

DataSet Section

(ldInst, prefix, lnInst, lnClass, DO 
name, fc)

The Dataset editor field is used from SCD file 
by IEC61850 OPC server. For more 
information, refer to Sequence of Events on 
Page 204.
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Update and Reload Configuration 

After the configurable objects in the object tree have been created, the configuration 
must be updated to the IEC61850 OPC Server(s). This is done by using the 
Management function.

To activate the update and activate the configuration:

1. Right-click Computer Node and select Management. Management Dialog 
window opens as shown in Figure 22.  

Figure 21. Management Selection
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2. Click Update configuration followed by Reload configuration or Update & 
Reload configuration. 

3. This completes the configuration of OPC Server instance and the OPC Server 
is ready to support OPC DA and AE for 800xA as configured in CET. 

Figure 22. Computer Node - Management Function

After Update/Reload of CET is done, due to OPC server restart, alarms that were 
in RTN status prior to Update/Reload action disappears.
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In some scenarios (for example. Computer crash while configuration of IEC 
61850 OPC Server), the CET project database gets corrupted and cannot be 
opened again from IEC 61850 Server CET tool after restarting the computer. 

To recover the CET project, perform the following steps:

1. Restart the machine. 
Fresh instance of the OPC server instance is running in the task manager.

2. Copy the system.xml file from the relevant OPC server instance folder to 
any other folder as backup. Ensure the correct system.xml is copied as 
backup.
The system.xml file under the IEC 61850 installation folder contains the 
entire project configuration. The system.xml file for each OPC server is 
stored in the respective instance folder under the following path: 
C:\Program files\ABB\61850 OPC server\OPC_61850\bin\ 
OPCS_IEC61850_x, where x is the OPC server instance number.

3. Create a new project in CET Tool and click OK in the pop-up error message 
window. 

4. Create a new computer node and a new IEC 61850 OPC Server.

5. Navigate to the scl import option and import the relevant system.xml file for 
that OPC Server instance. 

6. For an additional OPC server, repeat Step 2 and Step 5. 

7. Update and reload the configuration.
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Redundant IEC 61850 OPC Server Configuration
Perform the following steps to handle the OPC Server redundancy:

1. Create CET project in Primary IEC connect machine and configure all required 
configuration such as Alarms and events.

2. Configure Report client identity properties for OPC instance as primary OPC 
name (PrimOPC).

3. Export the CET project as *.pcmp.

4. Import the *.pcmp CET project in secondary OPC machine.

5. Change the Report client identity properties for OPC instance as Secondary

OPC name (SecOPC). 

Figure 23. Redundant OPC Server
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6. Select Computer Node object and open the Computer Management Tab. 

7. Click Update configuration and followed by Reload configuration. 

8. This completes the configuration of the redundant OPC Server on the 
secondary connectivity server.

Figure 24. Computer Node - Management

Figure 25. Computer Node - Update Configuration
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Affinity Configuration for IEC 61850 Projects with IEC 61850 Redundant 
Connectivity Server 

In an 800xA System with Redundant IEC61850 Connectivity Server nodes, Affinity 
configuration is recommended. Affinity configuration have Aspect Server 
(containing Alarm Manager subscribing to Event Collectors in Connectivity 
Servers) and All Operator Workplaces (clients subscribing to Connectivity Server 
OPC DA) configured to prefer Primary Connectivity Server node. 

Such configuration ensures that Alarm Manager and Operator Workplaces are 
subscribed to the same IEC 61850 DA and AE server instance running in Primary 
Connectivity Server node and thereby all OPC events arising from any Client DA 
activity being detected by Alarm manager without any loss of events in PPA Alarm 
and Event list.

In case of Primary Connectivity Server fails, the affinity preference for Alarm 
Manager and Operator Workplaces moves to Secondary Connectivity Server node. 

For details on configuring affinity, refer to System 800xA Post Installation 
(3BUA000156*) Manual.

CET Feature Pack Update

Updated Event Categories

All alarms/ event belonging to the IED object type is either part of system alarms or 
events. In this feature pack update normal process alarms coming via LN-GGIO 
during some configuration also have possibility to define them as System Alarm. 
This is used for additional monitored equipment assigned to the IED as an interface 
to the system.

The intention behind this update is to differentiate System and Process alarms from 
the IEDs to improve the display on PPA with the different alarm page definition.

• Process Alarm monitors the running process.

• System Alarm monitors the installed equipment.

PPA Automatic Load Balancing algorithm will be disabled when affinity 
configuration is deployed.
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Alarms/ events belonging to primary equipment like CBR is defined as process 
alarms/ events, which also includes GGIOs configured for these object types. These 
process alarms/ events appear in the process alarm/ event lists. 

Existing CET contains Event Categories 

• For Events :

– Simple Discrete Event

– Simple level Event

• For Alarms:

– Condition Discrete Event 

– Condition Level Event 

In Feature Pack release, CET contains following additional Event categories to 
categorize as Process Alarms/Events and System Alarms/Events, as shown in 
Figure 26. 
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• For Events :

– Process Simple Discrete Event

– Process Simple Level Event

– System Simple Discrete Event

• For Alarms :

– Process Condition Discrete Event

– Process Condition Level Event

– System Condition Discrete Event. 

Figure 26. Process and System Alarms or Events
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The above Event categories are further introduced in 800xA Alarm Collection 
Definition aspect to map to 800xA Category groups.

Further, a new event class DeviceHealth is introduced under Indication Events. The 
Condition Event category and Simple Event category of DeviceHealth is System 
Condition Discrete Event and System Simple Discrete Event by default.

The DeviceHealth Indication event can be configured for each IED in 
IED -> LD0 -> LPHD -> PhyHealth Data object to monitor the health of IED and 
generate System Alarm / Event in case of fault in IED . 

Area Name and Area Description Configuration

This update is intended to bring in Alarm and Event page consistence with 800XA 
standard. A new item Area on 800XA Alarm and Event page filters alarms and 
events based on the substation area.

Two new attributes as shown in Table 32 are added to all CET generated events by 
default. CET users can create and configure Area Name and corresponding Area 
Description according to the project. The pre-configured Area Names is assigned to 
each IED. 800XA client will be able to filter the Alarms and Events based on the 
Area Name and Area Description attributes.

For each OPC server instance, the Simple Event Categories and Condition Event 
Categories under Common Event Settings will be listed as Category Name 
properly mapped with Category Group in the Alarm Collection Definition aspect, 
only if those Categories are configured as OPC Alarm and Event to Data 
attributes of the Logical nodes with event class (Indication Events and 
Measurement limit Supervision Events).

Figure 27. Area Name and Area Description
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System Consistency Check during SCD file import

System Consistency Check is intended to be used with IEC 61850 protocol to check 
that the IED configurations are consistent with the compared IED configurations. 
According to the IEC61850 standard, IEDs can have two configuration revisions: 
one for data model and one for reporting. Configuration revision for data model is 
modeled on the LD0\LLN0\NamPlt\configRev object. It is the most important 
indicator of the configuration revision. Additionally, each Report Control block has 
a confRev attribute that defines the revision and the DataSet of RCB. System 
Consistency Check checks each LDs LLN0\NamPlt\configRev and confRev of each 
RCB.

The GUI tool is divided into two tabs: The System Consistency Check tab gives an 
overview of the project with the configuration consistency status of the IEDs as 
shown in Figure 28. The Options tab is used for setting the options for the update 
procedure as shown in Figure 28. Additionally, by clicking Details, a dialog on 

Table 32. OPC Alarm Event

Name Value/ Default Description

Area Name Specifies which area this IED belongs 
to.

Area 
Description

Description of area.
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consistency differences is shown.  

Figure 28. System Consistency Check
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When the tool is started, it will automatically perform the offline check. In the 
offline mode, the IED configuration revisions used in the CET project are compared 
to the specified IED configuration files. When the IED configuration file is imported 
to CET, the file name and location are saved, and the information is later used by the 
System Consistency Check tool. To enable the correct result of the comparison, 
always store the changed configuration files with the same name to the same 
location as the originals. If the location or the file name has changed, you can 
browse the new file with the Browse button. If the configuration is inconsistent, 
click the Details button for more detailed information. Finally, an individual 
configuration can be updated using the Update button. The Update All button 
updates all inconsistent configurations.

The Options view allows you to select same importing options that are available in 
the SCL Import tool. It is recommended that same options are used with both 
functions.

Figure 29. System Consistency Check - Options tab
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The Details view shows added or deleted LDs and RCBs. Additionally, it shows the 
modifications to the content of LD or RCB. 

Event Template Tool

Event Template Tool at Computer Node Level 

The Computer Node level Event Template tool allows export of configured Process 
Event Definitions in CET project into an Event Template file. The Event template 
can then be imported and reused into Process Event Definitions of same type in 
other CET projects.

System Consistency Check tool does not list the IEDs from earlier version of 
CET because the information about the original files is not known to the System 
Consistency Check tool, hence the file name is empty.

It is recommended to run System Consistency Check function for CET projects 
created with CET version containing System Consistency Check tool.
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The Event Template Tool is launched from context menu at Computer Node level as 
shown in Figure 30 and Figure 31.   

Figure 30. Event Template Tool - Context menu, Computer node level
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Event Template Tool at IED Level

The IED Event Template tool allows export of configured IED in CET project into 
an IED Template file. The IED template can then be imported and reused into IEDs 
of same type in other CET projects.

Figure 31. Event Template Tool 

Overwrite Existing definitions in import option must be selected in the Event 
Template Tool for overwriting the existing Process Event Definition property 
values in the system.
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The Event Template tool is launched from context menu at IED level as shown in 
Figure 32 and Figure 33.  

Figure 32. Event Template Tool - Context menu, IED level



Section 2  800xA IEC61850 OPC Server Event Template Tool

9ARD171387-510 D 115

Following three possible scenarios applicable for IED Template import: 

• CET Project does not contain Event Definition which is in IED Template file:

Event Definition is created, mappings are set, Overwrite existing definitions in 
import option is not used regardless of the selected value. 

• CET Project contains Event Definition which is in IED Template file, 
Overwrite existing definitions in import option is Not set: 

Existing event definition property values are not overwritten. 

• CET Project already contains Event Definition which is in IED Template file, 
Overwrite existing definitions in import option is set: 

Existing Event Definition property values are overwritten in CET Project, 
Overwrite existing event definition option is used. 

Figure 33. Event Template Tool 
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Analog Alarm Limit Configuration

This update is intended to configure and display Operator Limits, Units and ranges 
of Analog values on Faceplates and Trends.

In case of limit violations, analog values is also displayed for the limit value and 
physical unit. New fields are added for High High, Low Low, High, Dim, Max 
Range and Min Range.

If SCD file:

• contains limit configuration and units of analog signals, the same limit/units is 
shown in CET and OPC server.

• does not contain limit configuration and units of analog signals, default / empty 
limits/ units is shown in CET and OPC server.

Disturbance Recording
Disturbance Recording is the function of an IED which records the disturbances 
occurring due to interruptions in the received signals.

OPC Server can be configured to automatically scan for and transfer disturbance 
recording files to a specified directory on the Connectivity Server using IEC 61850 
OPC Server.

Disturbance Recorder items (included in the IED object type Control Connection 
Aspect) can be used to display the current disturbance recording settings of 
IEC61850 CET OPC server.

The following are the two methods to upload the disturbance recording file from the 
IED.

Disturbance Recording via MMS

1. Open CET.

2. In CET:

a. Expand Computer Node > OPC Server > Subnetwork > IED.
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b. Right-click and select Properties

Figure 34. IED With Properties Selected
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3. In the right-side Properties pane, update the fields mentioned in the Table 3 
under Disturbance Recording column. Set the Disturbance Recorder 
Enabled option to True. 

4. Set Disturbance Recorder Local Directory path of your choice. By default, it 
will be:

OPC Server Install Drive\COMTRADE

Disturbance Recording via FTP

1. Open CET.

2. In CET:

a. Expand Computer Node > OPC Server > Subnetwork > IED.

Figure 35. Sample IED Object Properties of RE_670 Series via MMS
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b. Right-click and select Properties.

Figure 36. IED With Properties Selected
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3. In the right-side Properties pane, update the fields mentioned in Table 3, IEC 
61850 Device Object Properties on Page 35, under Disturbance Recording 
via FTP column. 

– Provide the Username and Password as Administrator.

– Set the Disturbance Recordings Read Via FTP option to True.  

Figure 37. Sample IED Object Properties of RE_670 Series via FTP
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Table 33 and Table 34 details the recommended disturbance recording settings for 
different IEDs. 

Table 33. Disturbance Recording settings via FTP

SPA-ZC40x
RE_615 
Series

RE_615 
Series 2.x

RE_630 
Series

RE_670 
Series

[096]Disturbance Recording

Disturbance Recorder 
Delete Recording

False False False False False

Disturbance Recorder 
Enabled

True True True True True

Disturbance Recorder 
Local Directory

- - - - -

Disturbance Recorder 
Maximum Total File Size

0 0 0 0 0

Disturbance Recorder 
Polling Period

120 120 120 120 120

Disturbance Recorder 
Remote Directory

c:\comtrade\ \COMTRADE \COMTRAD
E\

\drec \drec\

[096]Disturbance Recording via FTP

Disturbance Recorder 
FTP Password

abb remote0004 remote0004 Administra
tor

Administrator

Disturbance Recorder 
FTP User Name

abb ADMINISTR
ATOR

ADMINISTR
ATOR

Administra
tor

Administrator

Disturbance Recordings 
Read Via FTP

True True True True True
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Table 34. Disturbance Recording settings via MMS

SPA-ZC40x
RE_615 
Series

RE_615 
Series 2.x

RE_630 
Series

RE_670 
Series

[096]Disturbance Recording

Disturbance Recorder 
Delete Recording

False False False False False

Disturbance Recorder 
Enabled

True True True True True

Disturbance Recorder 
Local Directory

- - - - -

Disturbance Recorder 
Maximum Total File Size

0 0 0 0 0

Disturbance Recorder 
Polling Period

120 120 120 120 120

Disturbance Recorder 
Remote Directory

c:\comtrade\ - \COMTRAD
E\

- -

[096]Disturbance Recording via FTP

Disturbance Recorder 
FTP Password

- - - - -

Disturbance Recorder 
FTP User Name

- - - - -

Disturbance Recordings 
Read Via FTP

False False False False False
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CET Project Maintenance
This section describes the guidelines to be followed while using the CET tool to 
Import and Export CET project.

Export CET Project

Before exporting, take a backup of the OPC configuration using the CET tool. 

1. Open the CET tool. 

2. Select File > Open/Manage project. Select the project the user want to export.

3. Click Export Project and click Open Project.

Figure 38. Open/Manage Project 
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4. Save the exported file. 

Import CET Project into Same CET Versions

Before importing, restore the OPC configuration using the CET tool.

1. Open the CET tool. Ensure that there are no open projects. 

2. Select File > Open/Manage project. 

Figure 39. Target File for Project Export
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3. Click Import Project.  

Figure 40. Open/Manage Project Dialog Box
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4. Browse for CET OPC Server Project backup .pcmp file to be imported. Import 
the project that was exported from the CET tool.  

Figure 41. Import BackupProject 
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5. Perform CET Update / Reload to initialize OPC Server.

Import CET Project into Newer CET Versions

To migrate the Backup CET OPC Server Project to new version perform the steps as 
follows:

Figure 42. CET OPC Server Project
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1. In Open / Manage Project dialog, Select the project under Projects made with 
previous product versions as shown in Figure 43. In this example HTY (ABB 
IEC 61850 OPC Server 1.1.2) is the project with older version. 

Figure 43. Open / Manage project
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2. Click Open Project. 

Figure 44. Project Conversion Wizard
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3. Click Next to view Project Conversion Wizard summary window. 

Figure 45. Project Conversion Wizard - Summary
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4. Click Next to view Project Conversion Wizard status window. 

Figure 46. Project Conversion Wizard - Status
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5. In Select version dialog, Select new version and Click Ok.  

Figure 47. Project Conversion Wizard

For revision releases, the Select Version window will display versions 3.x.
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6. Click Finish.  

Figure 48. Project Conversion Complete
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Figure 49. Finalizing Project Conversion 
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7. CET OPC Server Project Conversion is completed.  

The newly introduced CET Event Categories is not available in the migrated 
project in CET version 1.2.

To obtain the Event Categories, follow the below steps additionally:

8. Open Event Template Tool from Computer Node context Menu.

9. Click Open Template and browse \Program Files (x86)\ABB\61850 OPC 
Server to import CETEventCategories.xml.

10. Ensure Overwrite existing Definitions in import option is selected.

This will update only default Event Classes with New Event Categories. 

Figure 50. CET OPC Server Project 

Step 8 through Step 14 is applicable only for feature pack release. 
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Condition Category and Simple Event Category of User Defined Event Classes 
must be updated accordingly by the user.

11. Click Import Template.

12. Update & reload the new CET project. 

13. Restart the Connectivity Server Node.

14. Perform the following steps only after Primary and Secondary Connectivity 
servers are updated.

a. In Plant Explorer, Navigate to Service Structure > Event Collector, 
Service Perform an Upload for all IEC61850 Alarm and Event Service 
Groups. 

b. In Plant Explorer, Navigate to Library Structure > Alarm & Event > Alarm 
Collection Definitions, Alarm Collection Definition and check all 
IEC61850 Alarm Collection Definition Objects. 

If any Category Group is uncategorized, then manually categorize the 
group using respective Alarm Collection Definition Aspect. 



Section 2  800xA IEC61850 OPC Server IEC 61850 OPC Server Performance Data

9ARD171387-510 D 137

For details on applying the categories, refer to Figure 51. 

IEC 61850 OPC Server Performance Data
Substation with more than 80 IEDs can have two OPC server in a single SCD file. 
Each OPC server can have up to 16 subnetworks with a maximum number of 80 
IEDs in mixed combinations. 

For example, if one Subnetwork has more than 80 IEDs, split them across two OPC 
Server so that more than 80 IEDs are distributed across two OPC Servers. 

For more details on IEC 61850 OPC Server Performance Data, refer to System 
800xA System Guide Technical Data and Configuration (3BSE041434*) Manual.

Figure 51. Alarm Collection Definition - Category Group
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CET Diagnostics

IEC 61850 OPC Server Diagnostics

After the IEC 61850 OPC Server has been installed and configured, you can, for 
example, monitor and control the condition of connections in an IEC 61850 
network.

To access Online Diagnostics function in CET:

• Select Tools > Online Diagnostics as shown in Figure 52

Figure 52. Online Diagnostics from Tools menu
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• Select the object, right-click IEC 61850 Server object and select Online 
Diagnostics from the context menu as shown in Figure 53.

The server, a device, or data object is dragged and dropped from the Project 
Explorer’s Communication structure under the Online Diagnostics function. Select 
Project Explorer from the View menu if it is not already open.

Following options are available to:

• reset counters (restart the OPC server)
• view the event log file
• clear the log file

Figure 53. Online Diagnostics from context menu
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• enable or disable the SNTP client
• reconnect the online diagnostics

Diagnostic AE Client

Diagnostic events can be monitored and controlled using the Diagnostic AE Client

function. 

To enable diagnostic events:

1. Right-click the device.

2. Select Diagnostic AE client.  

Figure 54. Diagnostic AE client Selected
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3. Click Refresh to update the status information. To receive events from a certain 
device, the diagnostic events must be enabled for the selected device.  

Monitoring and Controlling IEC 61850 Subnetwork Activity

The IEC 61850 subnetwork activity can be monitored with the Online Diagnostics 
function.

To monitor and control IEC 61850 subnetwork activity:

1. Select a subnetwork you want to monitor in the object tree of CET.

2. Right-click the channel.

Figure 55. Diagnostic AE client Dialog Box
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3. Select Online Diagnostics.

Figure 56. Online Diagnostics from context menu



Section 2  800xA IEC61850 OPC Server Monitoring and Controlling IEC 61850 Subnetwork Activity

9ARD171387-510 D 143

In the Diagnostic counters field, you can monitor the subnetwork activity and the 
available properties. To reset Diagnostic counters, click Reset counters.

Allow IEC 61850 subnetwork into use by selecting the In use check box. On 
clearing the check box takes the subnetwork out of use. To update the diagnostic 
counters click Refresh.

Figure 57. Online Diagnostics of Subnetwork
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Monitoring and Controlling IEC 61850 Device Communication

The IEC 61850 device communication can be monitored with the Online 
Diagnostics function.

To monitor and control IEC 61850 device communication:

1. Select a device you want to monitor in the object tree of CET.

2. Right-click the device.

3. Select Online Diagnostics.

Figure 58. Online Diagnostics from context menu.
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In the Status information field, you can monitor the device status. The Diagnostic 
counters field provides information on device activity. To reset diagnostic counters, 
click Reset counters. To update the diagnostic counters click Refresh.

Figure 59. Online Diagnostics of Device
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Allow an IEC 61850 device into use by selecting the In Use check box. On clearing 
check box, the device is taken out of use.

Monitoring and Controlling IEC 61850 Data Object Communication

The IEC 61850 data object diagnostics can be monitored with the Online 
Diagnostics function.

To monitor and control IEC 61850 data object communication:

1. Select a data object you want to monitor in the object tree.
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2. Right-click the device.

3. Select Online Diagnostics.

Figure 60. Online Diagnostics from context menu
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In the Status information field, you can monitor and set attribute values and use 
control services. The Diagnostic counters field provides information on device 
activity.

Alarm and Event Configuration
Perform the following steps to configure alarms and events in CET:

1. Expand Computer Node > Process Event Definitions > Indication Events. 
In this example select AlarmState as shown in Figure 62.

Figure 61. Online Diagnostics of Data Object
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2. Expand the tree structure and select the attribute under the Logical Node. In 
Object Properties, under [040] OPC Alarm and Event, select AlarmState 
for Indication Event Type as shown in Figure 63.

Figure 62. Tree Structure with AlarmState Selected
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Repeat the Alarm and Event configuration for all Data Objects in all IEDs that 
generates Alarm and Event from OPC Server. 

Figure 63. SCD File Populated in CET
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Section 3  800xA IEC 61850 Uploader

This section describes how to work with IEC 61850 Uploader aspect user interface 
in 800x A Plant Explorer.

IEC 61850 Uploader aspect creates the communication and substation section of 
SCD file in Control Structure and Functional Structure of Plant Explorer 
respectively. 

The Uploader creates the following:

• Objects in the 800xA Control Structure using information retrieved by the SCL 
Model component parsing the communication section of the SCD file. The 
control structure represents the communication of IED and connect OPC server 
in 800xA. For example, IED, Logical device, Logical Node are added to the 
Control Structure.

• Objects in the 800xA Functional Structure using information retrieved by the 
SCL Model component parsing the substation section of the SCD file. The 
Functional Structure represents the physical layout of the substation with 
power generation and distribution equipment. For example, Substation, Voltage 
Level, Bay and Conducting Equipment objects are added to the Functional 
Structure. The object types in the Functional Structure contain Faceplates and 
Graphic Elements, using which operators can monitor and control a substation.

IEC 61850 Uploader has three main components.

1. Uploader User Interface

The Uploader user interface contains Standard and Advanced tab that allow 
user to set Upload options, select Object Type Library, select SCD file, and 
start upload operation and also view the status of the Upload progress.

During upload, all the log messages are written in to AppLog server. These log 
files can be viewed and analyzed using AfwAppLogViewer.



Creating IEC 61850 OPC Server Node in Control Structure Section 3  800xA IEC 61850 Uploader

152 9ARD171387-510 D

2. Retrieve

Retrieve component uses the SCL component and parses communication and 
substation section of SCD file selected by the user. This SCD file is also used to 
configure the IEC 61850 OPC Server using CET Tool. The details of SCD file 
are parsed to OCS files, which is understandable by the Append Component of 
Uploader. 

3. Append

Append component reads the OCS files created by Retrieve component of an 
Uploader. The Append Component creates the IEC 61850 communication 
structure in Control Structure using the OCS file data.

Creating IEC 61850 OPC Server Node in Control Structure
Perform the following steps to upload an SCD file and create IEC 61850 OPC 
Server Node:

1. Select Control Structure in 800xA Plant Explorer.

2. Right-click Root Domain and select New Object from the context menu.

3. In the New Object dialog box, select IEC61850 Object Types > IEC61850 
OPC Server and enter a name. 
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4. Click Next.

Figure 64. New Object Dialog Box

Always refresh the uploader aspect, whenever performing upload operation 
multiple times on a single OPC Server (to refresh the current uploader aspect, 
select another aspect and re-select the uploader aspect).
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5. In the Additional Arguments dialog box, click Add to create an OPC Server 
service group in Service Structure to connect to the OPC Server. 

Figure 65. Additional Arguments Dialog Box
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6. Select the Connectivity Server on which the OPC Server is configured and 
click OK.  

7. In the Additional Arguments dialog box, select an OPC Server from the 
OPC Server, Prog ID drop-down list.

8. Click Create to create a new IEC 61850 OPC Server.

9. This completes the creation and configuration of the OPC Server object in the 
Control Structure.

Figure 66. Select Connectivity Server(s) Dialog Box

For redundant configuration, select both Connectivity Server nodes that form the 
Primary and Secondary Connectivity Server nodes.

Figure 67. OPC Server ProgID Selection
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10. To confirm, go to the OPC Server object instance in Control Structure and 
check the OPC Data Source Definition Aspect. The aspect contains the 
details of the ProgID of the OPC Server to which the object is connected.  

IEC 61850 Uploader Options

The Uploader aspect consists of Standard and Advanced tabs. The User performs 
upload either using the Standard tab or the Advanced tab. The following are the 
workflow details of using these two tabs:

Upload Using Standard Tab

1. In Control Structure, OPC Server Object, click IEC61850Uploader aspect. 

Figure 68. OPC Data Source Definition Selection

Figure 69. IEC61850Uploader
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2. Select the Standard tab of the Uploader.

3. Browse the SCD file which needs to be imported under the OPC Server object. 

Figure 70. Standard Tab

Figure 71. Browsing SCD File
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Once the SCD file is selected, the Uploader parses the SCD file and lists the sub 
network in the SCD file in the Sub Networks drop-down list.   

4. Select the correct sub network from the drop-down list. 

Ensure that the same sub network that is imported in the OPC Server (to which 
the OPC data source definition Aspect of OPC Server object is pointing) is 
chosen here as well. 

In the Selected SCD file, the Conducting Equipments should not contain LNs 
from different OPC servers, however Bay can contain LNs from different OPC 
servers.

Logical Nodes assigned to PTW object are not supported by the Uploader.

In case the uploaded SCD file is configured with PTW object, Uploader displays 
a warning message and completes the upload process without uploading PTW 
related LNs.

To upload from Standard Tab, user must select the required IEC 61850 Object 
Type Library in Advanced Tab.

Figure 72. Sub Network Selection
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5. Select the library in the Advanced tab. 

6. Click Start to start the Uploader operation.   

Figure 73. Library Selection in Advanced Tab

This performs both Functional Structure and Control Structure upload.

Only One Upload operation must be performed at a time in a single 800xA 
System. Simultaneous upload must not be done from multiple nodes of 800xA 
System.

The objects displayed in the Control Structure are extracted from the 
Communication section of the SCD file and the objects displayed in Functional 
Structure are extracted from substation section. Hence it may be possible that the 
objects that are present in the Control Structure are not present in Functional 
Structure or objects that are present in the Functional Structure are not present in 
the Control Structure.
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Upload Using Advanced Tab

1. Click IEC61850Uploader aspect. 

2. Select the Advanced tab of the Uploader. 

Figure 74. IEC61850 Uploader Aspect

Figure 75. Uploader Advanced Tab
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3. Browse the SCD file which needs to be imported under the OPC Server object. 

4. Once the SCD file is selected the Uploader parses the SCD file and lists the sub 
network in the SCD file in the Sub Network drop-down list.

SCD file having multiple OPC server instances with the same sub network can 
be uploaded. 

For example: Substation with more than 160 IEDs in a sub network can have 
two OPC server instances, hence an SCD file having 80 IEDs are distributed 
among the OPC Servers.   

Figure 76. Browsing SCD File

Ensure that a correct SCD file is uploaded. A caution, Invalid SCD File! 
Uploader will Abort message appears if the uploaded SCD file contains 
special character (& or Space) in the description of any Conducting Equipment or 
Bay.
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Figure 77. Uploader Advanced Tab
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5. Select the correct sub network from the drop-down list. Ensure that the same 
sub network that is imported in the OPC Server (to which the OPC data source 
definition Aspect of OPC Server object is pointing) is chosen. 

OCS Filename: The Uploader assigns a unique OCS Filename in the Uploader 
Aspect of each OPC Server in Control Structure. The OCS Filename can also 
be modified by manually editing the filename.    

Figure 78. Sub Network Selection

It is recommended to take a backup of the existing OCS files, to prevent the 
Uploader from overwriting the files.

For SCD file with multiple subnetwork, the name of the subnetwork is suffixed 
with the OCS file name. For each subnetwork a new OCS file is created, hence 
for multiple subnetwork, multiple OCS files are created. 
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Multiple Retrieve operations can be performed sequentially for multiple OPC 
Server objects. In that case it is recommended that Filename specified in OCS 
Filename field is different for each OPC server while performing Retrieve 
operation. Otherwise the OCS file is overwritten with contents from the last 
retrieved SCD file 

Library Selection: Select the object type library which contains the object 
types that has to be uploaded. If the user has created his own version of the OT 
library, then that library must be selected here.

Functional Structure Upload: The substation section of the SCD file needs to 
be represented in the Functional Structure. The Uploader provides an option 
for automatic creation of the substation section in the Functional Structure.

Select this option to create a substation tree structure in the Functional 
Structure of the plant explorer. For Functional Structure upload to work, the 
Substation section of the SCD file should be present. 

While uploading, retain the default ocs file name. If user specific ocs filename is 
provided as a default ocs file name, ensure that for multiple upload on different 
OPC server instances, the ocs filenames are unique.

During retrieve operation, Uploader creates an intermediate 800xA OCS file 
format. During Append operation, Uploader reads the selected OCS file and 
uploads the configuration details.

In case the substation is not included in the configured SCD file, the Functional 
Structure Upload checkbox is disabled and unchecked to indicate that the SCD 
file does not contain Functional Structure objects (Substation) for upload. A 
message ‘No objects found for Functional Structure retrieve’ is displayed while 
uploading the SCD file.
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Upload if IEC OPC server configuration is same as SCD file content: 

– If this option is selected, the upload action fails if any non matching object 
are found.

– If this option is not selected, Upload action proceeds, if any non matching 
objects are found. Upload continues with the matching objects. 

Retrieve Objects: This starts the retrieve operation of the Uploader. During 
retrieve, the Uploader parses the SCD file and creates the OCS files. 

Upload if IEC OPC server configuration is same as SCD file content is 
performed during retrieve operation. 



IEC 61850 Uploader Options Section 3  800xA IEC 61850 Uploader

166 9ARD171387-510 D

Append Objects: Once retrieve operation is complete, click Append Objects. 

6. Now the Control Structure and Function Structure upload (if selected) is now 
complete.  

Figure 79. Advanced Tab - Retrieve and Append

Unique Naming, IED Signal Mapping, and Functional Structure Upload is 
performed during Append.

In the Functional Structure there can be multiple objects with the same name in a 
single tree. These are not duplicates. For information on the location of such 
logical nodes in the IED, refer to Controller Name aspect.
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IEC 61850 Uploader Options - Feature Pack Update

Substation Path in Functional Structure 

The substation path shows the selected node in the functional structure under which 
the substation is appended. Browse and select the path for the substation in 
functional structure, the substation path text box displays the selected object path. 
After upload substation node is added under the path present in the substation path. 

Figure 80. IEC 61850 Uploader Advanced tab



IEC 61850 Uploader Options - Feature Pack Update Section 3  800xA IEC 61850 Uploader

168 9ARD171387-510 D

Unique Naming of the Objects

Unique Naming of the Objects option is available in the advanced tab of Uploader 
aspect and is used for unique naming of objects in the Control and Functional 
structure of Plant Explorer. 

During Upload operation with the Unique Naming of the Objects option selected, 
the uploader modifies the LN names with the unique naming format as mentioned in 
Table 35 and the following message as shown in Figure 81 is displayed. 

  

By default the Unique Naming option is unchecked.

Figure 81. Unique Naming Pop up message during upload
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Figure 82 shows screen shot of control structure after Unique Naming option is 
selected during Upload. For example, IED, Logical device, Logical Node and 
Conducting Equipment objects.  

Figure 82. Unique naming of Primary Conducting Equipment in control structure
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Figure 83 shows screen shot of functional structure, when Unique Naming option is 
selected during Upload. For example, Voltage Level, Bay and Conducting 
Equipment objects.  

Figure 83. Unique naming of Secondary Equipment object in functional structure
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Table 35 details the format for changing object name after applying the unique 
naming.  

Table 35. Unique Naming Format for Conducting Equipment Objects

Object Type Unique Naming Format Example

Bay Substation Name + Voltage Level Name + Bay AA1AA1Q01, Bay

CBR Substation Name + Voltage Level Name + Bay + CBR AA1AA1Q01QA1, CBR

CE(Generic) Substation Name + Voltage Level Name + Bay + CE AA1AA1Q01BI1, 
Conducting Equipment

DIS Substation Name + Voltage Level Name + Bay + DIS AA1AA1Q01QB1, DIS

GEN Substation Name + Voltage Level Name + Bay + GEN AA1AA1Q01QC1, GEN

PTR Substation Name + Voltage Level Name + Bay + PTR AA1AA1Q01QD1, PTR

CTR Substation Name + Voltage Level Name + Bay + CTR AA1AA1Q01QE1, CTR

VTR Substation Name + Voltage Level Name + Bay + VTR AA1AA1Q01QF1, VTR

Voltage Level Substation Name+ Voltage Level Name AA1AA1, Voltage Level

LN IED+LD+"_"+LN AA1A1LD0_CVMMXU1, 
MMXU

Substation Not part of unique naming. Not Applicable

Subnetwork Not part of unique naming. Not Applicable

IED Not part of unique naming. Not Applicable

LD Not part of unique naming. Not Applicable
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IED Signal Mapping

IED Signal Mapping aspect is available for each Conducting Equipment, 
Substation and Voltage Level, and, Bay in the Object Type Library. 

Extended Object Type Library containing the IED Signal Mapping aspect can be 
used to deliver the projects with customized faceplates as per industry standards 
with variety of IEDs.

The IED Signal Mapping aspect is used for defining the properties and 
corresponding rules for the specified IED type (for example. REF615, REM615, 
REF630, REB670, REG670, and REL670). These properties are by default 
available in Control Connection aspect of the Conducting Equipment and are used 
for faceplate configuration.

On selecting IED Signal Mapping option during upload, uploader checks the 
properties of the IEDs available in the SCD file and appends the respective 
properties from IED Mapping Aspect to display Item IDs in the Control Connection 
Aspect for the Conducting Equipment and Bay. 

Uploader ensures that all the properties in IED Signal Mapping aspect are available 
and matching with the properties of the Control Connection aspect, otherwise the 
uploader stops with an error message. 

After upload, the properties are updated in the Control Connection aspect in the 
Control Structure and Functional Structure of the 800x A Plant Explorer. Figure 84 
shows the IED Signal Mapping Aspect of Bay Conducting Equipment object in 
Object Type Structure. 
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The IED Signal Mapping Aspect contains:

• Property Name to define a signal name, 

Figure 84. IED Signal Mapping Aspect

IED Signal Mapping aspect supports configuration of only one type of IED under 
a Bay and Conducting Equipment.

This is because only one set of properties can be accommodated for signals from 
an IED to display in Control Connection aspect.
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• IED column containing the mapping of each signal to the respective IEC 61850 
data attribute of a given IED type.   

The properties defined under IED Type Column in the IED Signal Mapping Aspect 
is defined using:

• Instance Number 

The Property Name and IED name of the IED Signal Mapping Aspect must be 
unique and the Property Name field must not be left blank.

Figure 85. IEC61850 IED Mapping Signal Aspects
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where the first part of the property is LNType_InstanceNumber and format as 
shown:

MMXU_1.A.res.cVal.mag

XSWI_1.Pos.stVal

Table 36 describes the fields used in IED Signal mapping Aspect.  

Table 36. IED Mapping Signal Aspect

Item Label Description

Used for browsing the .csv file to either Import or Export the 
.csv file containing the properties. 

 It is recommended to create a .csv file in the local folder, 
before exporting the properties. 

Used for importing the properties from the .csv file and 
overwrite the data in the existing table of the IED Signal 
Mapping Aspect. 

Browse to the particular .csv file and then import the 
properties to override the existing properties of the IED 
Signal Mapping aspect.

Used for exporting the properties from the IED Signal 
Mapping Aspect to the .csv file. 

Browse and select a particular .csv file and then export the 
IED Signal Mapping Aspect properties.

An empty row is added to the table of the IED Signal 
Mapping Aspect.

Selected row is deleted from the table of the IED Signal 
Mapping Aspect.
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An empty column is added to the table of the IED Signal 
Mapping Aspect.

The selected IED type column is deleted from the table of the 
IED Signal Mapping Aspect. 

 The Property Name cannot be removed from the IED 
Signal Mapping Aspect.

Table 36. IED Mapping Signal Aspect

Item Label Description
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Figure 87 shows Control Connection Aspect in the Control Structure IED Signal 
Mapping option is selected during upload. 

Figure 86. Control Structure - Control Connection Aspect
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Figure 87 shows Control Connection Aspect in the Functional Structure IED Signal 
Mapping option is selected during upload.  

Figure 87. Functional Structure - Control Connection Aspect
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Section 4  800xA IEC 61850 Alarm and Event
Configuration

This section describes how to configure Alarms and Events in 800xA Plant Explorer 
using IEC 61850 OPC Server. 

The IEC 61850 OPC Server forwards alarms and events from the IEC 61850 
network to the 800xA system. The IEC 61850 OPC Server runs on Connectivity 
Server and is connected to 800xA using standard 800xA functionality for third party 
OPC A&E Servers. 

To increase the level of integration, a specific Alarm Collection Definition object is 
included in IEC 61850 Connect. The Alarm Collection Definition object maps the 
following:

• The alarm severity attribute of IEC 61850 OPC Server to AE priority in 800xA.

• The IEC 61850 OPC Server event categories to 800xA category groups.

Alarm and Event List Configurations can be created for each business unit to adapt 
to the existing alarm and event concepts of the BU. One example feature used in 
other connectivities is to add the object description column to the alarm/event list. 
By adding one/more operator-friendly description of an object to the Description 
field of the Name aspect of an object, this information can be used in alarm/event 
lists instead of the "low-level" object name.
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Configuring Alarms and Events in Plant Explorer
Once the AE server gets configured in CET and SCD file is imported in PPA, the 
following steps are to be performed to configure alarm and events for IEC 61850 
Connect.

Perform the following steps to configure alarm and events:

1. Select Service Structure in Plant Explorer.

2. Right-click Event Collector, Service and select New Object from the context 
menu to create a service group.

Figure 88. New Object Selection
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3. In the New Object dialog box, enter the Service Group name and click 
Create.

Figure 89. New Object Dialog Box
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4. Right-click the previously created Service Group (IEC) and select New Object 
from the context menu to create a service provider object.

Figure 90. Service Provider Object
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5. In the New Object dialog box, enter the service provider name and click 
Create.

6. Select the created Service Provider object.

Figure 91. New Object Dialog Box With Service Provider

If there is a redundant AE server, then create a second provider object.
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7. Select Service Provider Definition from the Aspects List.

8. Select the Configuration tab in Aspect Preview pane.

9. From the Node drop-down list, select a connectivity server on which the AE 
server resides and click Apply.

10. Click Special Configuration tab.

11. Click Override located beside Description of AE Server drop-down list.

Figure 92. Service Provider Definition Aspect

Figure 93. Connectivity Server Selection
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12. Select the description of AE Server from the Description of AE Server drop-
down list.

13. Select the service group created in Step 3.

14. Select Service Group Definition from the Aspects List.

15. Select the Special Configuration tab from the Aspect Preview pane.

16. Under OPC A&E Server, select alarm server from the Alarm Server drop-
down list.

Figure 94. Special Configuration Tab

Ensure that the correct description of AE Server is selected. This must be the 
same as the ProgID of the AE Server to connect.

Figure 95. Alarm Server Selection

Ensure that the correct Alarm Server is selected. This must be the same as the 
ProgID of the AE Server to connect.
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17. Under Source Object Handling, select Tracking Source Object Interceptor 
from the Object Handler drop-down list.

18. Select IEC 61850 Connect Source Name Interpreter from the Source 
Translator drop-down list.

On selecting the alarm server, the collection definition appears automatically. If 
not, click the New button located beside the Collection Definition drop-down list 
as shown in Figure 96.

Figure 96. Collection Mapping

Figure 97. Source Object Interceptor Selection

Figure 98. Source Object Handling
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19. Click Apply to configure the above settings.

20. When the user clicks on Apply, the Upload button is enabled.

21. Click Upload. A new alarm collection aspect is created as shown in Figure 99. 
The alarm collection definition needs to be configured with reference to the 
alarm collection aspect provided by 61850 Connect.    

The upload is now complete, and the 800xA system is now configured to receive 
alarm from the IEC 61850 AE Server. Optionally, the upload step can be skipped 
and the reference/default collection definition object provided with Connect can 
be used directly. This is possible only when the default event categories of the 
OPC Server are used (no changes have been made to the OPC Server event 
categories).

A new alarm definition object is created if more than one OPC Servers are used in 
the system. New alarm definition object is created in the below mentioned path:

Library Structure > Alarm & Event > Alarm Collection Definitions, Alarm 
Collection Definition > IEC 61850 OPC AE Server, Alarm Collection 
Definition.
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22. The Category Group of the newly created alarm collection definition must be 
categorized if required, as per the default alarm collection definition provided 

Figure 99. Special Configuration Tab
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by IEC 61850 Connect as shown in Figure 100.  

Figure 100. Default Alarm Collection Definition 
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23. In Service Structure, select Services > Alarm Manager, Service > Basic, 
Service Group.

24. In Aspects List pane, select Service Group Definition.

25. In Aspects pane, select the Special Configuration tab.

Figure 101. Service Group

Figure 102. Service Group Definition
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26. In the Special Configuration tab, check Log Non state-related changes. 

27. Click Apply.  

Alarm Priority Configuration

In 800xA, there are four default priority levels configured for alarms in the Alarm 
Collection Definition aspect of IEC 61850 OPC AE Server. The user can manually 
configure the alarm priority levels in the Plant Explorer and the severity levels in the 
IEC CET.

Alarm Priority Configuration in Plant Explorer

To configure the alarm priority levels, follow the steps below:

1. Open Plant Explorer.

Figure 103. Log Non state-related changes in Special Configuration Tab

The alarms list shows an alarm in a new row if there is a change in condition. If 
there is only a change in subcondition, then the new subcondition is displayed in 
the same row.
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2. Navigate to Library Structure.

3. Navigate to Alarm & Event > Alarm Collection Definitions > IEC 61850 
OPC AE Server.

4. Select the Alarm Collection Definition aspect.

5. In the aspect preview window, select Alarm Priority Mapping. The Alarm 
Priority Mapping dialog box appears.

6. In the Alarm Priority Mapping dialog box, the four default alarm priority 
levels will be displayed. The user can configure Priority Levels up to 32 levels. 

Figure 104. Alarm Priority Mapping Selection
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The user can set the OPC Severity values for each Priority Level under OPC 
Severity Range. 

Alarm Shelving

To enable the Alarm Shelving feature create a new property in Aspect System 
Settings named Alarm Management and set the value to true as shown in 

Figure 105. Alarm Priority Mapping Dialog Box



Alarm Shelving Section 4  800xA IEC 61850 Alarm and Event Configuration

194 9ARD171387-510 D

Figure 106.

Once the feature is enabled, Shelve is visible. Note that a license check will be 
performed when opening the alarm list. If the license is not available for Alarm 
Management, disturbance will be generated. This disturbance will not interrupt the 
Alarm Shelving.

800xA IEC 61850 Alarm and Event for Conducting Equipment

Alarms and events are related to the primary equipment objects that the operator 
works with. The alarms and events message includes the tag name of the related 
primary equipment object. 

Currently, the Logical Node object in the IEC 61850 environment, which is the 
source of the alarm, transmits the alarms. From a usability point of view the Logical 
Node has no functional value on the alarm page for the operator as it represents only 
a logical function that can also be executed in a different equipment.

The Conducting Equipment (physical SA Component that is automated with one of 
several functions such as breaker, switch, motor, or pump) sends the alarm. So the 
Object Name column in the alarm list displays the conducting equipment name if 

Figure 106. Alarm Shelving
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the alarm is generated from a Logical Node which is child of Conducting 
Equipment, else displays the Logical Node name. 

Figure 106 shows the Alarm and Event List Aspect for Bay Conducting Equipment. 

Use the event list for generating High Warning and Low Warning messages on 
the PPA, as the Simple events are available only in the event list.

Figure 107. Alarm and Event List Aspect 
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Figure 106 shows High Alarm for Bay Conducting Equipment. 

Figure 108. High Alarm



Section 4  800xA IEC 61850 Alarm and Event Configuration Redundant OPC AE Configuration

9ARD171387-510 D 197

Redundant OPC AE Configuration

Perform the following steps to configure OPC AE for redundancy:

1. Select Service Structure in Plant Explorer.

2. Right-click Event Collector, Service and select New Object from the context 
menu to create a service group.

Before configuring Redundant OPC AE, pre-configuration steps has to be 
performed. For step-by-step procedure refer Alarm and Event Configuration on 
page 148.

Figure 109. New Object Selection
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3. In the New Object dialog box, enter a name and click Create.

4. Click Next.

5. Right-click the previously created service group (IEC) and select New Object 
from the context menu to create a Service Provider object.

Figure 110. New Object Dialog Box

Figure 111. Service Provider Object
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6. Select the previously created Service Provider object.

7. Select Service Provider Definition from the Aspects list.

8. Click Configuration tab.

9. Select a connectivity server on which the AE server resides.

10. Click Service Group and select the Service Group Definition from the 
Aspects list.

11. Click Special Configuration tab.

If there is a redundant AE server, then create a second Service Provider object.

Figure 112. Connectivity Server Selection
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12. Under OPC A&E Server, select the alarm server from the Alarm Server 
drop-down list.

13. Right-click the previously created service group (IEC) and select New Object 
(Redundant) from the context menu to create a service provider object.

14. Repeat the Step 6 to Step 12.

15. Click Apply to configure the above settings.

16. Click Upload.

17. In Library Structure expand Alarm & Event > Alarm Collection Definitions.

Figure 113. Alarm Server Selection

Once the alarm server is selected, the collection definition appears automatically. 
If not, select IEC 61850 OPC AE Server Instance [1] from the drop-down list.
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18. Select IEC 61850 OPC Server related Collection Definition.

19. In the Aspects List, select Alarm Collection Definition.

20. In Aspect preview pane, change the view to Configuration View.

21. In the Configuration tab, select Supports Refresh and Require Dual 
Acknowledge check box. This check box is selected by default for the system 
created IEC 61850 OPC AE Server Instance, Alarm Collection Definition 
aspect.

Figure 114. OPC AE Server 

Figure 115. Alarm Collection Definition Aspect
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22. Click Apply. 

Redundant OPC DA Configuration
Perform the following steps to achieve redundant configuration in a redundant OPC 
DA setup.

1. Create the OPC Server object under Root Domain in the Control Structure.

2. Create an OPC Server service group in service structure to connect to the OPC 
Server. To achieve this, in the Additional Arguments dialog box, click Add.

For user created IEC 61850 OPC AE Server Instance, Alarm Collection 
Definition aspect, the Supports Refresh check box must be manually selected.

For redundant IEC 61850 OPC AE Server, Require Dual Acknowledge check box 
must be manually selected.

Figure 116. Configuration Tab

The alarm limits or levels can only be set from IEDs. They cannot be read in Plant 
Explorer or written to IED.
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3. This action lists the PCs connected. Select the two Connectivity Servers (Both 
Primary and Redundant) and click OK.

4. In the Additional Arguments dialog box, select the OPC Server ProgID.

5. Check for the two OPC DA service providers that are created under the same 
OPC DA service Group. 

Figure 117. Connectivity Server Selection

Figure 118. OPC Server ProgID Selection For Redundant Server
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6. The Configuration of Redundant OPC Servers in the Plant Explorer is now 
complete. 

7. Repeat all the steps mentioned in the subsections Upload Using Standard Tab 
on page 156 and Upload Using Advanced Tab on page 160.

Sequence of Events
The internal events (process values, corresponding trigger values that caused the 
event, time stamps and quality information) are used as a trigger foundation for 
reporting and logging. This information is grouped using a data set. The data set is 
the content basis for reporting and logging. The data set contain references to the 
data and the data attribute values.

The data set specifies which data is to be monitored and reported. The next task is to 
define when and how to report or log the information. The reporting model provides 
two kinds of s:

1) Unbuffered

2) Buffered

The buffered and unbuffered reporting starts with the configuration of the s.

The specific characteristic of the buffered is that it continues buffering the event 
data as they occur according to the enabled trigger options if there is, for example, a 

While creating Redundant OPC Server in Control Structure, the newly 
created OPC Server Service Provider in Service Structure does not change to 
Service state automatically.

In such cases, select Special Configuration tab of the erroneous Service Provider 
and click Refresh. Select the correct OPC DA Server instance and disable or 
enable service to bring the current status to Service.

After upload, there may be some objects which are present in Control Structure 
only and not in Functional Structure and some objects which are present in 
Functional Structure only and not in the Control Structure. In such cases, for the 
objects present only in Control Structure “Control Structure” aspect is present 
and for the objects present only in Functional Structure “Functional Structure” 
aspect is present.
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communication loss. The reporting process continues as soon as the communication 
is available again. The buffered guarantees the Sequence-of-Events (SoE).

If there is loss of communication, the Unbuffered does not support the SoE. So, to 
support the SoE, correct data set and s must be configured while designing and 
generating the SCD file.
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Section 5  Addition and Modification of
Graphic Elements

This section describes how to create and modify user defined faceplates and graphic 
elements containing only IEC 61850 data along with other connectivity data.

Faceplates and Graphic Elements Containing IEC 61850 
Data

While creating faceplates or graphic elements for an object of existing default set of 
object types. Perform the following steps to create the faceplate/faceplate 
element/graphic element in the chosen object type:

While creating a faceplate for an object type that is not part of the default set of 
object types, create a new object type under the ‘Functional Objects’ folder. The 
new object type name and type name in SCD file must be the same.

Perform the following steps, to create/edit a faceplate for an object type:

1. Open the Plant Explorer.

2. Navigate to Library Structure > Libraries, Library Collection > 
IEC61850_ObjectTypes_GraphicsExtLib, Extension Library > 

This function is only supported and applicable for 800xA IEC 61850 releases 
before Feature Pack. This section must be ignored for Feature Pack release.

Only the users with application engineer rights can create faceplates and graphic 
elements.

Graphic elements and faceplates must be created only for Functional Structure 
object types.
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IEC61850_ObjectTypes_GraphicsExtLib 1.0.0, Extension Library 
Version.

3. Select the Extension Library Version Definition aspect from the Aspects 
List.

Figure 119. Plant Explorer With Extension Library Selected

Figure 120. Aspects List With Extension Library Version Definition Selected
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4. Click New Version in Aspect Preview.

5. In the New Version dialog box, select the number in Major version and click 
Create.

Figure 121. Aspect Preview With New Version Selected

Ensure that the number for major version is greater than 1.

Figure 122. New Version Dialog Box
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6. IEC61850_ObjectTypes_GraphicsExtLib 2.0-0, Extension Library 
Version is created under Library Structure > Libraries, Library Collection 
> IEC61850_ObjectTypes_GraphicsExtLib, Extension Library.

7. Navigate to the object type in the Object Type Structure.

8. Select the object on which you want to create/edit the faceplate (For example, 
the DIS, Object Type).

9. Add/edit faceplate elements, faceplates, and graphic elements in the Aspect 
List. 

For more information, refer to System 800xA Engineering Process Graphics 
(3BSE049230*).

Faceplates and Graphic Elements Containing Data from Other Connectivity

The faceplates and graphic elements have to be created on the instances in 
Functional Structure using standard 800xA functionalities.

Figure 123. Object Type Group With Object Selected
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All graphic elements and faceplates created are customizable using standard 800xA 
functionalities.

Configuring the Control Connection Aspect of Functional Objects

The Control Connection aspect of the functional objects can have predefined 
attributes for use in the faceplates/graphic elements. These predefined attributes can 
be made to obtain data from a particular type of logical node, which are associated 
with a functional object. For example, a functional object CBR can be associated 
with LNs XCBR and CILO. The predefined attribute in the CBR object can be 
configured to get data from XCBR logical node. This can be achieved by providing 
a name syntax for the predefined attribute of the functional object (CBR in the 
above example). The following is the syntax:

<LN name>_<instance number>.<attribute of the LN>.

Example

A predefined attribute in the Control Connection aspect of CBR Object Type can 
contain an attribute like ‘XCBR_1.BlkOpn.stVal’. 

This means that the attribute ‘XCBR_1.BlkOpn.stVal’, refers to ‘Blkopn.stVal’ 
attribute of the first instance of the XCBR Logical Node (first instance under the 
functional object CBR).

During upload, the Uploader parses this syntax and puts the appropriate OPC Item 
ID for this attribute.

Use the above syntax to predefine the Control Connection aspect of the functional 
objects and use this predefined attribute in the faceplate element/graphic element.

F

For more information on addition and modification of graphic elements, refer to 
System 800xA Engineering Process Graphics (3BSE049230*).
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Figure 124 shows a snapshot of an example of Control Connection aspect in the 
CBR Object Type. 

Figure 124. Example of Control Connection Aspect Configuration in a Functional 
Object.
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Figure 125 shows an example of OPC Item ID that is added by the Uploader, by 
parsing the name given in the Control Connection aspect.

s

Figure 125. Example of OPC Item ID Addition by Uploader
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Section 6  Guidelines to Import and Export

This section describes the guidelines to be followed to Import and Export the 800xA 
IEC 61850 Project (.scd files).

Exporting 800xA IEC 61850 Project
To export the SCD files, consider the following guidelines:

1. Go to Start > Programs > ABB Industrial IT 800xA > System > Import 
Export.

2. Open the Plant Explorer and select the Functional Structure.

3. Drag and drop the Functional Structure to the Import / Export dialog box.

4. Select the option Include Dependencies in Add Item dialog box and click 
OK.

5. In the Import / Export dialog box, click Save to save the .afw files to the 
desired location.

6. Select the Control Structure.

7. Drag and drop the Control Structure to the Import / Export dialog box.

8. Select the option Include Dependencies in Add Item dialog box and click 
OK.

It is recommended to do Functional Structure export and Control Structure 
export, and store them in the same .afw file.

First export the Functional Structure starting from the "Substation" Object.
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9. In the Import / Export dialog box, click Save to save the .afw files to the 
desired location.

Importing 800xA IEC 61850 Project
To import the IEC 61850 Connect Structure files into the Plant Explorer:

1. Browse to the Functional Structure .afw files.

2. Double-click on .afw file to open Import Export.

3. The progress of loading file appears. Click Done when finished.

4. In the Import / Export dialog box, 

a. Select the Structure View button.

b. Right-click Functional Structure and select Import.

5. In the Import objects and aspects dialog box, click Finish.

6. Browse to the Control Structure .afw files.

7. Double-click .afw file to open Import Export.

8. The progress of loading file appears. Click Done when finished.

9. In the Import / Export dialog box, 

a. Select the Structure View button.

Export the Control Structure starting from the IEC 61850 OPC Server object.

If the Control Structure has dependencies, the OPC DA Service associated with 
the OPC Server object is not exported. The user must manually create the new 
OPC DA Service and assign the newly created service to the OPC Server object. 
Refer to this procedure in Import CET Project into Same CET Versions on page 
124.

After import or restore, manually configure the OPC DA Connector Service.

Import Functional Structure before importing Control Structure.
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b. Right-click Control Structure and select Import.

10. In the Import objects and aspects dialog box, 

a. Select the Import Options tab.

b. Under Overwrite Existing Data, select Yes.

c. Click Finish.

11. Go to Service Structure. Create a New Service Group and Service Provider for 
IEC 61850 OPC DA Server (Example: SG and SP) as shown in Figure 126. 

Ensure that the exact node name and the ProgID from the Configuration and 
Special Configuration tabs are selected respectively.

Figure 126. Service Group 1
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12. Go to OPC Server Object and refer this Service in the OPC Data Source 
Definition aspect.

Figure 127. Service Group 2
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Section 7  Reconfiguration

This section describes the reconfiguration of SCD files, importing reconfigured 
SCD file to the IEC 61850 OPC Server and uploading the reconfigured SCD files to 
the Plant Explorer.

Overview
When the user re-configures the substation or communication section, it is assumed 
that a new version of the SCD file is generated. The user uploads the new version of 
the SCD file. The Uploader preserves all the aspects that are added by the user on 
the existing object instances.

If some of the objects are added, deleted and renamed in the updated SCD file, then 
the Uploader adds, deletes, and renames the corresponding object instances in the 
Plant Explorer.

Reconfiguring SCD Files
To make changes to the existing uploaded SCD Files in Plant Explorer, follow the 
instructions provided in Section 2, Working with SCD Files of System 800xA - AC 
800M IEC 61850 Configuration (9ARD171385*).
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Importing Reconfigured SCD File to the IEC 61850 OPC 
Server

To import the reconfigured SCD file to IEC 61850 Connect OPC Server, follow the 
instructions provided in SCL Import on page 93.

Uploading Reconfigured SCD File to the Plant Explorer
To upload reconfigured SCD file to the Plant Explorer, follow the instructions 
provided in Upload Using Standard Tab on page 156 and Upload Using Advanced 
Tab on page 160.  

During the reconfiguration of the SCD files, if objects are added and the 
reconfigured SCD files are imported in the CET, the SCD files are populated over 
the existing objects.

After renaming or deleting objects in SCD files, delete the existing configuration 
present in CET tool and import the modified SCD file to the CET. To perform 
this action, follow the instructions provided in SCL Import on page 93.

If the default library is used during direct upload and the user defined library is 
used during reconfiguration, then only the changed object belongs to the user 
defined library.

The corresponding object name in the SCD file is saved in the Controller Name 
aspect of the Plant Explorer. So, if the object name is changed in the Plant 
Explorer, then the Uploader preserves the name of the object instances.

Each Logical Node object is uniquely identified. The following is the naming 
convention for Logical Node Objects:

Subnetwork\IED\Logical Device\Logical Node.

These Logical Node objects are shared among Control Structure and Functional 
Structure. While uploading in Functional Structure, if the Logical Node exists in 
Control Structure, the same object is inserted in Functional Structure and if the 
Logical Node exists in the Functional Structure, the same object is inserted in the 
Control Structure. Else, it creates a new Logical Node object.

Renaming an object in SCD configuration creates a new object in the Plant 
Explorer after uploading, if that particular object does not exist in the Plant 
Explorer.
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Adding, deleting, and renaming of the IED, the Logical Devices, the Logical Nodes, 
the Voltage Levels, the Bay, the Conducting Equipment, the Child Logical Nodes of 
Bay and the Child Logical Nodes of the conducting equipment is supported in the 
Uploader.
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Section 8  Object Type Specific Graphics for
BAY

This functionality provides the development of an object type specific faceplate for 
Bay. The object type specific faceplate in the Bay level is able to access data from 
different conducting equipments and logical nodes. The faceplates included in the 
Bay object types must have conducting equipment or logical node references. The 
Uploader provides the complete path for each reference during instantiation or 
upload. So, the business unit faceplate/library developer can define the properties 
for Bay object in the Object Type Structure. The Uploader sets the complete path for 
each property during the upload operation.

Configuration
This section describes the configuration of the object type specific graphics for Bay 
and guides an user to obtain the values in Bay level faceplate.

Perform the following steps to get values in the Bay level faceplate:

1. Define property at Bay level for the conducting equipment or logical node.

2. Latebind mechanism to refer to attributes of the process object.

3. Set the complete path of conducting equipment or logical node to each property 
reference during the upload operation.

Define Property at Bay Level

The application engineer defines the properties for conducting equipment and 
logical nodes that are required for the faceplate development. This section explains 
the procedure to define the property for the conducting equipments/logical nodes.
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A property must be defined for each conducting equipment or logical node. The 
property is an unresolved reference for the conducting equipment/logical node in 
the Object Type Structure. The unresolved references are used in the faceplate 
expression builders and are required to bind with the appropriate process objects 
during runtime.

Procedure to Define Property

Perform the following steps to define the properties:

1. Open Plant Explorer.

2. Navigate to Library Structure.

3. Create a new major version of the library and associate below mentioned 
extension libraries to this version.

– IEC61850_ObjectTypes_UploaderExtLib

– IEC61850_ObjectTypes_CCAExtLib

– IEC61850_ObjectTypes_ControllerNameExtLib

– IEC61850_ObjectTypes_PCAUploadExtLib

– IEC61850_ObjectTypesGraphicsExt

4. Navigate to Object Type Structure > IEC61850 Object Types, Object Type 
Group.

5. Select the new library version of IEC61850 Object Types.

6. Select Functional Objects and select Bay.

User cannot delete the newly created version of Extension library 
IEC61850_CCAExtLib because it is a part of main IEC 61850 base library 1.0.0.

To delete the new version of CCA extension library, make the base extension 
library of CCAExtnLib active.

The above mentioned extension libraries are the minimum required extension 
libraries. The user can associate all other extension libraries if required.

For information on guidelines for creating user defined/BU specific libraries, 
refer to Section 10, Guidelines for Creating User Defined/BU Specific Libraries.
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7. Add General Properties aspect to the Bay object.

8. Right-click the General Properties aspect and select Details.

9. In the Details dialog box, 

a. Select the Aspect Info tab.

b. Clear the Inheritance enabled check box.

c. Click Add to add the aspect key.

d. In the next window, select Auto-instantiate Aspect and click OK.

Figure 128. General Properties Details Selection
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e. Click Apply.

10. Right-click the General Properties aspect and select Config View.

11. In the General Properties dialog box,

a. Click Add to add properties.

b. Enter the Name as per the syntax: CE-CBR_1.

Figure 129. Details Dialog Box

Figure 130. General Properties Config View Selection
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c. Enter the other fields as shown in Figure 131.

The General Properties aspect of the Bay object is used to define the properties and 
the type. Each property must be a string. It must have both read and write 
permission. Figure 131 defines the property CE-CBR_1.

Configuring Properties to Obtain Data from Conducting Equipment

The General Properties aspect of the Bay objects can have predefined properties 
which are referred in faceplates/graphics elements. These predefined properties can 
be made to obtain data from a particular conducting equipment.

The conducting equipment is referred by the object type and the instance. The 
instance can be a reference to the type of conducting equipment, object type, or the 
instances of the object type under a particular Bay.

Table 37 lists the various scenarios to add properties to the General Properties 
aspect of the Bay to refer the conducting equipments.

Figure 131. General Properties Dialog Box
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Configuring Properties to Obtain Data from a Logical Node

The General Properties aspect of the Bay objects can have predefined properties 
which are referred in faceplate/graphic elements. These predefined properties may 
be used to obtain data from a particular Logical Node.

Table 37. Add Properties to Refer to The Conducting Equipments.

Instance Description

CE-CBR_2 A part of property name which specifies “CBR_2” is from the 
conducting equipments. This property is a symbolic reference to 
the second instance of type CBR.

CE-CBR_2N A part of property name which specifies “CBR_2N” is from the 
conducting equipments. This property is a symbolic reference to 
the second instance of a conducting equipment and its name 
starts with CBR.

CE-CBR_2T A part of property name which specifies “CBR_2T” is from the 
conducting equipments. This property is a symbolic reference to 
the second instance of type CBR.

CE-CBR100 A part of property name which specifies “CBR100” is from the 
conducting equipments. This property is a symbolic reference of 
a conducting equipment and its name is CBR100 which is 
present in a particular Bay.

In case of item id filling in the General Properties aspect of a Bay.

When updating the General Properties aspect of a Bay, there is a limitation for 
type based and name based convention. The identifier (name/type) referring to 
the Logical Nodes & Conducting Equipments must not contain an underscore 
character (_) in the identifier. 

The workaround is to follow the direct naming of the Logical Nodes & 
Conducting Equipments.



Section 8  Object Type Specific Graphics for BAY Define Property at Bay Level

9ARD171387-510 D 229

The Logical Node is referred by the object type and the instance. The instance can 
be a reference to the type of the Logical Node, Object type, or the Instances of the 
Logical Node under a particular Bay.

Table 38 lists the various scenarios to add properties to the General Properties 
aspect of the Bay to refer the Logical Nodes.

Configuring Properties to Obtain Data from Logical Node (Child of 
Conducting Equipment)

The General Properties aspect of the Bay object have predefined properties which 
are referred in faceplates/graphic elements. These predefined properties are made to 
obtain data from a particular Logical Node which is the child of specific conducting 
equipment.

Table 38. Add Properties to Refer to The Logical Nodes

Instance Description

LN-XCBR_2 A part of property name specifies “XCBR_2” is from Logical Nodes. 
This property is a symbolic reference of second instance of type 
XCBR.

LN-XCBR_2N A part of property name specifies “XCBR_2N” is from Logical 
Nodes. This property is a symbolic reference of second instance of 
a Logical Node and its name starts with CBR.

LN-XCBR_2T A part of property name specifies “XCBR_2T” is from Logical 
Nodes.This property is a symbolic reference of second instance of 
type XCBR. 

LN-XCBR100 A part of property name specifies “XCBR100” is from Logical 
Nodes.This property is a symbolic reference of a Logical Node and 
its name is XCBR100 comes and is present in a particular Bay.
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Table 39 lists the 16 different ways of defining property.

Latebind Mechanism

Latebind Mechanism to Refer to Attributes of Conducting Equipment

During the faceplate development, the business unit faceplate/library developer can 
utilize the Latebind mechanism provided by PG2 graphics to refer to the attributes 
of conducting equipment or logical node.

Table 39. Add Properties to General Aspect to Refer to Logical Nodes 

Test Case Property Name

Case 1 CE-CBR_1-XCBR_1 

Case 2 CE-CBR_1-XCBR_1N

Case 3 CE-CBR_1-XCBR_1T

Case 4 CE-CBR_1-XCBR100 

Case 5 CE-CBR_1N-XCBR_1

Case 6 CE-CBR_1N-XCBR_1N

Case 7 CE-CBR_1N-XCBR_1T

Case 8 CE-CBR_1N-XCBR100

Case 9 CE-CBR_1T-XCBR_1

Case 10 CE-CBR_1T-XCBR_1N

Case 11 CE-CBR_1T-XCBR_1T

Case 12 CE-CBR_1T-XCBR100

Case 13 CE-CBR100-XCBR_1

Case 14 CE-CBR100-XCBR_1N

Case 15 CE-CBR100-XCBR_1T

Case 16 CE-CBR100-XCBR100 
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It is not possible to bind the system entities during the configuration process. The 
Graphics Builder can be accessed through Expression Functions. The functions 
locate the entities based on the names that implement late binding.

The following is an example function for latebinding:

LateBoundPropertyRef

Returns reference to a property found based on the specified parameters, or null. 
The function also activates a subscription to property by the rate of updateRate. 
aspectSpec may be left empty on all aspects of the object.

The following are the parameters for this function:

• String objectPath: A string that refers to the target object,

• String aspectSpec: The name of the aspect or “(empty string)”.

• String propName: The name of the data entity being referred to.

• Boolean unique.

• Integer updateRate.

In AspectSpecifier, a search is done with respect to the name specified or on all 
objects if it is specified as ““.

Single reference functions return a single value. All single reference functions 
possess a property called the Boolean Unique. This property enables the user to 
decide if the search yields a unique value. 

If the Unique is set to True and there is more than one reference based on the 
function parameters, the function returns a null value.

If the Unique is set to False, the function arbitrarily returns one value of several 
candidates found.

Figure 132 shows how the input field control in graphics editor can be binded to 
different object during runtime.
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Input field control can be dragged and dropped into the New Graphic editor.  

Select the properties of input field. 

The value for “propertyreference” is LateBoundPropertyRef.

The following are the parameters bind the Input field to a specific OPC attribute:

• CE\:CBR_1 specifies a specific process object. The Uploader sets the value for 
CE\:CBR_1 in General properties aspect, which specifies the complete path 
of process object.

• Control Connection provides Aspect information. 

• CILO_1.Mod.ctlVal, True, 0 specifies the attribute from the Aspect.

Example for the late bind reference:

Figure 132. Process Graphic Editor 
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LateBoundPropertyRef($'.:General Properties:CE-CBR_1', "Control 
Connection", "MMXU_1.PPV.phsAB.cVal.mag", True, 0)

Set Complete Path

Set the Complete Path of Conducting Equipment to Each Property

During the upload operation, the IEC Connect Uploader sets value for each 
property.

Path:

[Functional Structure]Root/AA1/E/Q1/CBR1

Examples of value set value by the Uploader are:

Q1 is a Bay with the General Properties aspect. The following are the properties of 
Q1:

1. CE-CBR_1

2. CE-CBR_2

The Uploader sets the following value for the property “CE-CBR_1”:

[Functional Structure]Root/AA1/E/Q1/CBR1

The Uploader sets the following value for the property “CE-CBR_2”:

[Functional Structure]Root/AA1/E/Q1/CBR2

Limitation

LateBound functions cannot differentiate if multiple objects with the same name are 
present in the same path and if LateBound functions are used for accessing data 
from same properties of the same aspect.

When multiple logical nodes with same name are assigned to a single Bay, using 
Latebinding mechanism it is not possible to ascertain which LN data is used in the 
Property value of the General properties aspect.

For example. A Bay having two CVMMXU1 Logical Nodes are assigned from 
different sources and with the Property value containing path to CVMMXU1, it is 
not possible to ascertain which LN value will be used in runtime. 
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Section 9  Object Type Specific Graphics for
IED

This functionality provides for the development of the Object Type Specific 
Faceplate for IED.

Configuration
This section describes the configuration of the ObjectType Specific Graphics for the 
IED.

Object type specific graphics for IED

Object type specific graphics for IED to refer attribute from Logical Nodes. The 
Control Connection aspect of the IED has predefined attributes for use in the 
faceplate/graphic element. These predefined attributes can be configured to obtain 
data from a particular type of the logical node that is associated with a logical 
device. The data type of these IED level attributes must match the data type 
referring attributes. This must be achieved by providing a name syntax for the 
predefined attribute of the IED. There are eight different ways to define property. 

Table 40 describes the syntax for defining property:

Table 40. Add Properties to CCA of IED

Test Case Property Name

Case 1 LD_1-XCBR_1.BlkOpn.stVal 

Case 2 LD_1-XCBR_1T.BlkOpn.stVal

Case 3 LD_1-XCBR_1N.BlkOpn.stVal
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Figure 133 shows a predefined attribute in the Control Connection aspect of the 
IED Object Type.

Case 1

LD_1-XCBR_1.BlkOpn.stVal

or

LD_1-XCBR_1T.BlkOpn.stVal

This refers to the ‘BlkOpn.stVal’ attribute of the first instance of the XCBR type 
Logical Node (child of first instance of the Logical Device).

Case 4 LD_1-XCBR100.BlkOpn.stVal

Case 5 LD100- XCBR_1.BlkOpn.stVal

Case 6 LD100- XCBR_1T.BlkOpn.stVal

Case 7 LD100- XCBR_1N.BlkOpn.stVal

Case 8 LD100- XCBR100.BlkOpn.stVal

Figure 133. IED Control Connection

Table 40. Add Properties to CCA of IED (Continued)

Test Case Property Name
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During upload, the Uploader parses this syntax and puts the appropriate OPC Item 
ID for this attribute.

Case 5

LD100- XCBR_1.BlkOpn.stVal

or

LD100- XCBR_1T.BlkOpn.stVal

This refers to the ‘BlkOpn.stVal’ attribute of the first instance of the XCBR type 
Logical Node (child of the Logical Device named LD100).

During upload, the Uploader parses this syntax and puts the appropriate OPC Item 
ID for this attribute.

When updating the Control Connection aspect of an IED, there is a limitation for 
type based and name based convention. The identifier (name/type) referring to 
the LD or LN must not contain an underscore character (_) in the identifier. 

The workaround is to follow the direct naming of the Logical Device/Logical 
Node.
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Section 10  Guidelines for Creating User
Defined/BU Specific Libraries

This section provides the guidelines for creating user defined/BU specific libraries.

Guidelines for Creating User Defined/BU Specific 
Libraries

This section describes the guidelines to create a new version of the base library 
IEC61850_ObjectTypes. To use this new library, create a new version of all the 
extension libraries and link these new extension libraries to the newly created base 
library version. 

Ensure that the following extension libraries are mandatorily created: 

• IEC61850_ObjectTypes_UploaderExtLib - This contains the Uploader aspect.

• IEC61850_ObjectTypes_CCAExtLib - This contains the Control Connection 
aspect.

• IEC61850_ObjeVctTypes_ControlerNameExtLib - This contains the 
Controller Name aspect.

• IEC61850_ObjectTypes_PCAUploadExtLib - This contains the PCA Upload 
Type aspect. 

If the above extension libraries are not created, then an error occurs during the 
upload operation.
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While making the new version of libraries and extension libraries, ensure that a 
major version of the base and extension libraries is created. Create major versions 
such as 2.0-0 or 3.0-0 and not minor or revisions of base libraries like 1.1-0 or 1.0-1. 
This is because the IEC 61850 Connect delivers only minor versions and revisions 
(1.0-0) of the base library in future. If the user creates the minor versions or 
revisions of the library, there is a potential risk that the libraries delivered by the IEC 
61850 Connect overwrites the user defined libraries. 

Navigate to the Object Type Structure and open the newly created base library. Add 
new object types to this library. When new object types are created, ensure that the 
name of the object types is the same as the name with which it is identified in the 
SCD file. The Uploader reads the type information in the SCD file and looks for the 
object type with the same name. So if the above procedure is not followed, the 
Uploader does not recognize the new object types.

When the new object types are created, the following aspects must be mandatorily 
added to the newly created object types.

• Control Connection aspect 

• Controller Name aspect.

• PCA Upload Type aspect.

During upload in the Uploader, select the newly created object type library to 
upload. The Uploader has a user interface to select this newly created library. Refer 
to Figure 134.

It is recommended to develop customized faceplates in Object Type Structure 
after creating user defined library in Library Structure. Upload the SCD file, 
selecting the user defined library to get the customized faceplates on all instances 
of respective objects.

When a new library version is created, the control connection elements of 
faceplate within the new library still point to properties of main library version.

For proper faceplate reconfiguration, click on "." in the object column of the 
reconfiguration dialog and select correct object.

At the instance level, the user must not modify the Controller Name aspect.



Section 10  Guidelines for Creating User Defined/BU Specific Libraries Guidelines for Creating User 

9ARD171387-510 D 241

For more details on Library handling refer to System 800xA 5.1 Configuration 
(3BDS011222*).

Figure 134. Library Selection

While creating a new user library, the faceplates and Graphics elements appear as 
undeployed (VB related) and as Unapproved (PG2 related).

User needs to run display tool to deploy those elements. Alternatively 
deployment can be done via context menu on each element. Uploader operation is 
recommended to be performed after deploy.
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Section 11  SCD Information

This section provides the SCD information for the IEC 61850 Uploader and the 
OPC Server.

SCD File Information for IEC 61850 Uploader

Communication Section (Control Structure)

The Uploader creates objects in the Control Structure using information retrieved by 
the SCL Model component parsing the communication section of the SCD file. For 
example: IED, Logical device, Logical Node are added to the Control Structure. The 
following table lists the description of each parameter of the SCD file.

SCD Information Description

Subnetwork

(Name, Description)

The Name and Description field of subnetwork is used 
from the SCD file by IEC 61850 Uploader.

IED

(Name, Description)

The Name and Description field of IED is used from SCD 
file by the IEC 61850 Uploader.

Logical Device

(Name, Description)

The Name and Description field of Logical Device is 
used from the SCD file by the IEC 61850 Uploader.

Logical Node

(Name, Description)

The Name and Description field of Logical Node is used 
from the SCD file by the IEC 1850 Uploader.

Conducting Equipments

(Name, Description)

The Name and Description field of Conducting 
Equipments is used from the SCD file by the IEC 61850 
Uploader.
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Substation Section (Functional Structure)

The Uploader creates objects in the Functional Structure using information 
retrieved by the SCL Model component parsing the substation section of the SCD 
file. For example: Substation, Voltage Level, Bay and Conducting Equipment 
objects are added to the Functional Structure. The following table lists the 
description of each parameter of the SCD file. 

The Functional Structure objects such as Isolator and Breaker is instantiated by the 
IEC61850 Uploader in the Functional Structure and is based on substation section 
of the SCD file. The Functional Structure objects contain the faceplates. The 
operators use these faceplates to operate the respective devices. Based on the 
application requirements, the faceplates and Object Types can be further engineered.

SCD Information Description

Subnetwork

(Name, Description)

The Name and Description field of substation is used 
from the SCD file by the IEC 61850 Uploader.

Voltage Level

(Name, Description)

The Name & Description field of Voltage Level used from 
the SCD file by the IEC61850 Uploader.

Bay

(Name, Description)

The Name & Description field of BAY used from the SCD 
file by the IEC61850 Uploader.

Logical Node

(Name, Description)

The Name and Description field of Logical Node is used 
from the SCD file by the IEC 1850 Uploader.

Conducting Equipments

(Name, Description)

The Name and Description field of Conducting 
Equipments is used from the SCD file by the IEC 61850 
Uploader.

Conducting Equipments 
with Child LN.

(Name, Description)

The Name and Description field of Conducting 
Equipments with Child LN is used from the SCD file by 
the IEC 61850 Uploader.
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Private Section Handling in SCD file

For small extensions either by a manufacturer or for a specific project, the private 
parts can be used. The advantage of private parts is that the data content is preserved 
at data exchange between tools.

Private data entities appear on several levels of the SCL. The contents of these XML 
elements is as seen from the SCL, transparent text. If the private part contains XML 
data, then it must use an explicit name space, which cannot be the SCL name space. 
The Private element allows also to reference other files by means of an URL at its 
source attribute. 

The handling within tools is as follows:

The private data is owned by a tool respective by a tool category (for example, a 
picture generator). The owner is allowed to modify its contents, and normally is the 
only one able to interpret the data. All other tools, which read private data, have to 
preserve (store) its contents on SCL import, and regenerate it at the same place if an 
SCL file containing this part is produced/exported.

Data Subscription

For data subscription, OPC Server need to be assigned as a client to RCB () as 
shown in the Figure 135.
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Figure 135. Data Subscription
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Data Format / Data Set

It is a grouping of all required data attributes present in the IED which needs the 
data subscription from the OPC Server. Refer to the following Figure 136 to form 
the data set.

Version Handling of SCD File

User should make sure that same version of SCD file is used across all the nodes in 
the system.

Figure 136. Data Format / Data Set
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Appendix A  Renaming Object Names

This appendix provides the information on how to rename the Logical Nodes.

Renaming Object Names
Perform the following steps to rename the object:

1. Select the object to be renamed.

2. Select the Name Aspect from the Aspects list.

3. In the Name text box, rename the existing name.

Example of the objects that can be renamed.

• Substation

• Voltage Level

• Bay

• Logical Node 

It is recommended that the renaming must be done from the Functional Structure 
and not from the Control Structure.

It is recommended not to rename the IED name. The source name is not changed 
if the user has changed the object names in the functional structure.The source 
name in the Alarm list is displayed as per the configuration in the OPC Server.
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Appendix B  Deleting OPC Server Instance

This appendix provides the procedure to delete the OPC Server instance.

Deleting OPC Server Instance
Perform the following steps to delete the OPC Server instance using the CET tool:

1. Select the OPC Server instance to be deleted.

2. Right-click and select Delete.

Figure 137. Delete Selection
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3. Right-click Computer Node object and Select Management.

4. In the Management pane, click Update & reload configuration.

Figure 138. Management Selection (Redundant)

Figure 139. Update & reload configuration Button
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Deleting IEC 61850 OPC Server from 800xA System
While deleting the OPC Server Object from Control Structure, it is recommended to 
delete the corresponding OPC DA Service from the Service Structure.

Perform the following steps to delete the Service in Service Structure:

1. Navigate to Service Structure > OpcDA_Connector > Service.

2. Navigate to the Service Group for that IEC61850 OPC server object.

3. Right-click and delete the corresponding Service Group.

Deleting Unused IEC 61850 OPC Server Instances
Unused OPC Server instances appear during configuration of IEC61850 Service 
Providers > Special Configuration in PPA Service structure. It is recommended to 
remove unused OPC Server instances during configuration.

Perform the following steps to remove the unused OPC Server instances:

1. Locate current CLSIDs. 

Locate current OPC server CLSID from instance.ini file (located in sys default 
C:\sc\prog\61850_OPC_Server\IEC61850 OPC 
Server\bin\OPCS_IEC61850_1\instance.ini) 

For example. mys instance.ini: 

[Instance] 

DAServerClsId={B3828BEA-9DCF-4E96-896C-7CCF766B95B0} 

AEServerClsId={0076A00C-D18F-422E-9E2D-A4E6C0FE218A} 

2. Remove unnecessary OPC Server instances from registry. 

Search through registry using regedit command from 
HKEY_LOCAL_MACHINE for ABB.IEC61850_OPC_. This will find for 
both DA and AE server. 

The entries will be located in: 

(The two following two keys may or may not exist in registry, depending on the 
installed product.) 
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ABB.IEC61850_OPC_DA_Server.Instance[1] in 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\. If the CLSID key under this 
key is not among the CLSIDs in instance.ini, the ABB... key can be deleted. 

ABB.IEC61850_OPC_AE_Server.Instance[1] in 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\. If the CLSID key under this 
key is not among the CLSIDs in instance.ini, the ABB... key can be deleted. 

(The following will be found in registry) 

Next set of keys is found in; 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\ (e.g. 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes\CLSID\{B3828BEA-9DCF-
4E96-896C-7CCF766B95B0}\ProgID). The entries is found for both DA and 
AE servers. If the CLSID is not among the CLSIDs in instance.ini, the "{...}" 
key can be deleted.

3. Remove unused DCOM registrations. 

Start dcomcnfg (Run > dcomcnfg). Navigate to Component Services > 
Computers > My Computer > DCOM Config. In the list locate the multiple 
instances of IEC 61850 OPC DA Server Instance [1]. Delete the DCOM 
registrations without the current CLSID as Application ID. 
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Appendix C  Sequence for Faceplates

This appendix provides the deployment sequence of the graphic elements\ faceplate 
elements for circuit breaker, transformer, and generator faceplates.

Deployment Sequence for Circuit Breaker Faceplate
Table 41 lists the deployment sequence for circuit breaker faceplate.

This function is only supported and applicable for 800xA IEC 61850 releases 
before Feature Pack. This section must be ignored for Feature Pack release.

Table 41. Deployment Sequence for Circuit Breaker Faceplate

Serial 
No.

Aspect Name Aspect Type

1 CB Measurement Faceplate Element

2 geCircuitbreakerReducedCB Graphic Element

3 fpeBlockingInterlockCB Faceplate Element

4 fpeMainviewCB Faceplate Element

5 geAlarmSquareCB Graphic Element

6 fpeAlarm_CB_User Faceplate Element

7 fpeBlockingCB Faceplate Element

8 fpeEditInterlockTextCB Faceplate Element

9 fpeInterlockCB Faceplate Element

10 fpeMeasurement16CB Faceplate Element
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Deployment Sequence for Transformer Faceplate
Table 42 lists the deployment sequence for transformer faceplate.

11 fpeParametersCB Faceplate Element

12 fpeSimulationCB Faceplate Element

Serial 
No.

Aspect Name Aspect Type

13 fpeStatusCB Faceplate Element

14 fpeStatusExt16CB Faceplate Element

15 geAlarmControlCB Graphic Element

16 geFeedbackCB Graphic Element

17 geMeasurementCB Graphic Element

18 Alarm Control Graphic Element

Table 42. Deployment Sequence for Transformer Faceplate

Serial 
No.

Aspect Name Aspect Type

1 TFR Measurement Faceplate Element

2 geTransformerTR Graphic Element

3 fpeBlockingInterlockTR Faceplate Element

4 fpeMainviewTR Faceplate Element

5 geAlarmSquareTR Graphic Element

6 fpeAlarms16TR Faceplate Element

7 fpeBlockingTR Faceplate Element

8 fpeEditInterlockTextTR Faceplate Element

Table 41. Deployment Sequence for Circuit Breaker Faceplate (Continued)
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Deployment Sequence for Generator Faceplate
Table 43 lists the deployment sequence for generator faceplate.

9 fpeInterlockTR Faceplate Element

10 fpeMeasurement16TR Faceplate Element

Serial 
No.

Aspect Name Aspect Type

11 fpeParametersTR Faceplate Element

12 fpeSimulationTR Faceplate Element

13 fpeStatusTR Faceplate Element

14 fpeStatusExt16TR Faceplate Element

15 geAlarmControlTR Graphic Element

16 Alarm Control Graphic Element

Table 43. Deployment Sequence for Generator Faceplate

Serial 
No.

Aspect Name Aspect Type

1 Generator Measurement Faceplate Element

2 geGeneratorGEN Graphic Element

3 geGeneratorReducedGEN Graphic Element

4 geGeneratorUsedwithReducedGEN Graphic Element

5 fpeMainviewGEN Faceplate Element

6 geAlarmSquareGEN Graphic Element

7 fpeAlarms16GEN Faceplate Element

8 fpeAVRBlockingGEN Faceplate Element

Table 42. Deployment Sequence for Transformer Faceplate (Continued)
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9 fpeAVRModeHandlerGEN Faceplate Element

Serial 
No.

Aspect Name Aspect Type

10 fpeAVRModesGEN Faceplate Element

11 fpeCapDiaParamGEN Faceplate Element

12 fpeDirAdjustGEN Faceplate Element

13 fpeDirAdjustParamGEN Faceplate Element

14 fpeEditModeTextGEN Faceplate Element

15 fpeGOVBlockingGEN Faceplate Element

16 fpeGOVModeHandlerGEN Faceplate Element

17 fpeGOVModesGEN Faceplate Element

18 fpeInterlocksGEN Faceplate Element

19 fpeLocalModeHandlerGEN Faceplate Element

20 fpeMeasurements16GEN Faceplate Element

21 fpeModeIndGEN Faceplate Element

22 fpeSetpointParamGEN Faceplate Element

23 fpeSimulationGEN Faceplate Element

24 fpeStastopHandlerGEN Faceplate Element

25 fpeStatusExt16GEN Faceplate Element

26 fpeSyncGEN Faceplate Element

27 geCapDiaGEN Graphic Element

28 gdGeneratorGEN Graphic Element

29 geAlarmcontrolGEN Graphic Element

30 Alarm control Graphic Element

Table 43. Deployment Sequence for Generator Faceplate (Continued)
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Serial 
No.

Aspect Name Aspect Type

32 geFeedbackGEN Graphic Element

33 geGenTagNameGEN Graphic Element

34 geMeasActPowBargraph Graphic Element

35 geMeasRePowBargraph Graphic Element

36 geMeasurementGEN Graphic Element

Table 43. Deployment Sequence for Generator Faceplate (Continued)
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Appendix D  System Status Viewer

This appendix provides information on the system status viewer.

The function system status adds the functionality for providing and displaying status 
for IED and Logical Node objects. The user navigates to the System Status Viewer 
aspect on the OPC Server Object to check for the individual status of each IED and 
the Logical Nodes under them.

Figure 140. System Status Viewer
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The 'Health' attribute, a part of 'Common Logical Node' node object (and hence a 
part of all logical nodes) provides the status of the Logical Nodes. A property 
translation aspect is used to translate the 'Health.StVal' attribute to 'S_Status' which 
is understandable by the system status viewer.

Table 44 shows the Values of 'Helath.StVal' and the corresponding values of 
'S_Status' and their status as seen on the System Status Viewer aspect.

The Time column in Figure 140 displays the time and date of the last change in 
status. The attribute "Health.t" in control connection of all the Logical Node Object 
Type is mapped to 'S_Time' attribute by the Property Translator aspect. The 
System Status Reporter aspect reports this 'S_Time' attribute to the System Status 
to display in the Time column.

The real time values of the above mentioned attributes such as 'Health.Stval' and 
'Health.t' are available from the IEC 61850 OPC Server for all the Logical Node 
objects.

While CCT engineering, RCB dataset of LPHD LN for the physical devices to 
include Health.stVal, PhyHealth.stval attributes. This ensures proper updation of 
device status in System Status Viewer.

Table 44. Status Seen in System Status Viewer

Health.Stval S_Status
Status seen on 
‘System Status 
Viewer’ aspect

1 0

3 1

2 2
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The Generic Logical Node object do not carry the support for the System Status 
Viewer. The Generic Logical Node Object Type is present to cater to non-standard 
Logical Nodes/User defined Logical Nodes. As we do not know the health 
information of these Logical Nodes, the System Status reporter variables cannot be 
mapped. Hence this Generic Logical Node Object Type does not carry the System 
Status Reporter aspect.

To get the System Status Reporter functionality, configure this manually.

System Status Reporter for IED Object

The Status of the IED in an IEC 61850 network is represented by the attribute 
'PhyHealth.stVal' of the LPHD Logical Node of the IED. So, the System Status 
Reporter aspect uses this attribute to report the status of the IED to the System 
Status Viewer.

The real time value of the above mentioned attribute 'PhyHealt.stVal' is available 
from the IEC 61850 OPC Server on the LPHD object for each IED.

The System Status Viewer Aspect 

The System Status Viewer aspect is on the following Object Types:

• Sub network Object Type

• IED Object Type

• Logical Device(LD) Object Type

For subnetworks having large number of IEDs (around 50 or more), opening 
System status viewer at Subnetwork, IED or LD level causes 100% CPU load for 
2 to 3 minutes.

It is recommended not to perform other runtime operations on that machine while 
Opening System Status Viewer aspect.
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Appendix E  Logical Nodes and Primary
Object

Logical nodes can be connected to Primary objects according to the following table. 
If no specific function is written in the Comment column, the connection is used for 
displaying the substation structure based on identification for the events and alarms.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment

Substation

LLN0 (Logical Node 
Device)

Loc data used for station/ remote switch 
state.

SIMG (Insulation 
Medium Supervision 
(gas))

LN to supervise the insulation medium, for 
example the gas volumes of GIS (Gas 
Insulated Switchgear) regarding density, 
pressure, temperature, etc.
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CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

M* Metering and Measurement

G* Generic references.

Q* 

Voltage Level

SIMG (Insulation 
Medium Supervision 
(gas))

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

M* (Metering and 
Measurement)

G* Generic references.

Q*

Bay

LLN0 (Logical Node 
Device)

Loc data used for bay remote switch state.

LPHD (Physical 
Device Information)

SIMG (Insulation 
Medium Supervision 
(gas))

SARC (Monitoring 
and diagnostics for 
arcs)

LN to supervise the gas volumes of GIS 
(Gas Insulated Switchgear) regarding arcs 
switching or fault arcs.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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SIML (Insulation 
medium supervision)

LN to supervise the insulation medium, for 
example the gas volumes of GIS (Gas 
Insulated Switchgear) regarding density, 
pressure, temperature, etc.

SPDC (Monitoring 
and diagnostics for 
partial discharges)

LN to supervise the gas volumes of GIS 
(Gas Insulated Switchgear) regarding 
signatures of partial discharges.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

M* Metering and Measurement

P* Protection functions.

R* Protection related functions.

G* Generic references.

T* Instrument transformers.

Q*

Circuit Breaker (CBR)

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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XCBR (Circuit 
Breaker)

This LN is used for modelling switches with 
short circuit breaking capability. Additional 
LNs for

example SIMS, etc. may be required to 
complete the logical modelling for the 
breaker being

represented.

CSWI (Switch 
Controller)

Mandatory The switch control LN handles all switchgear 
operations from the operators and from 
related automatics. It checks the 
authorization of the commands. 

It supervises the command execution and 
gives an alarm in case of an improper ending 
of the command. It asks for releases from 
interlocking, synchrocheck, autoreclosure, 
etc. if applicable.

RREC (Automatic 
reeclosing)

AC closing relay is a relay that controls the 
automatic reclosing and locking out of an AC 
circuit interrupter (IEEE C37.2- 1996).

After any successful protection trip, the 
automatic reclosing tries 1 to 3 times to 
reclose the open breaker again with different 
time delays assuming a transient fault.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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RSYN 
(Synchrocheck/synch
ronizing or 
Synchronism check)

Synchronizing or synchronism-check device 
is a device that operates when two AC 
circuits are within the desired limits of 
frequency, phase-angle and voltage, to 
permit or to cause the paralleling of these 
two circuits (IEEE C37.2-1996).

To avoid stress for the switching device and 
the network, closing of the circuit breaker is 
allowed by the synchrocheck only, if the 
differences of voltage, frequency and phase 
angle are within certain limits.

CILO (Interlocking 
function at bay level)

Interlocking may be totally centralized or 
totally decentralized. Since the interlocking 
rules are basically the same on bay level 
based on all related position indications, the 
different interlocking LNs may be seen as 
instances of the same LN class

Interlocking (IL).

All interlocking rules referring to a bay are 
included in this LN. Releases or blockings of 
requested commands are issued. In the case 
of status changes affecting interlocking, 
blocking commands are issued.

PTRC (Protection 
Trip Conditioning)

This LN is used to connect the “operate” 
outputs of one or more protection functions 
to a common “trip” to be transmitted to 
XCBR. 

In addition or alternatively, any combination 
of “operate” outputs of the protection 
functions may be combined to a new 
“operate” of PTRC.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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SIML (Insulation 
medium supervision)

LN to supervise the insulation medium, for 
example the gas volumes of GIS (Gas 
Insulated Switchgear) regarding density, 
pressure, temperature, etc.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Disconnector (DIS)

XSWI (Circuit Switch) This LN is used for modelling switches 
without short circuit breaking capability, for 
example disconnectors, air break switches, 
earthing switches, etc. 

Additional LNs, SIMS, etc. may be required 
to complete the logical model for the switch 
being represented. The closing and opening 
commands is subscribed from CSWI. 

If no services with real-time capability are 
available between CSWI and XSWI, the 
opening and closing commands are 
performed with a GSE-message.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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CSWI (Switch 
Controller)

Mandatory The switch control LN handles all switchgear 
operations from the operators and from 
related automatics. 

It checks the authorization of the commands. 
It supervises the command execution and 
gives an alarm in case of an improper ending 
of the command. It asks for releases from 
interlocking, synchrocheck, autoreclosure, 
etc. if applicable.

RREC (Automatic 
reeclosing)

AC closing relay is a relay that controls the 
automatic reclosing and locking out of an AC 
circuit interrupter (IEEE C37.2- 1996).

After any successful protection trip, the 
automatic reclosing tries 1 to 3 times to 
reclose the open breaker again with different 
time delays assuming a transient fault.

RSYN 
(Synchrocheck/synch
ronizing or 
Synchronism check)

Synchronizing or synchronism-check device 
is a device that operates when two AC 
circuits are within the desired limits of 
frequency, phase-angle and voltage, to 
permit or to cause the paralleling of these 
two circuits (IEEE C37.2-1996).

To avoid stress for the switching device and 
the network, closing of the circuit breaker is 
allowed by the synchrocheck only, if the 
differences of voltage, frequency and phase 
angle are within certain limits.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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CILO (Interlocking 
function at bay level)

Interlocking may be totally centralized or 
totally decentralized. Since the interlocking 
rules are basically the same on bay level 
based on all related position indications, the 
different interlocking LNs may be seen as 
instances of the same LN class

Interlocking (IL).

All interlocking rules referring to a bay are 
included in this LN. Releases or blockings of 
requested commands are issued. In the case 
of status changes affecting interlocking, 
blocking commands are issued.

PTRC (Protection 
Trip Conditioning)

This LN is used to connect the “operate” 
outputs of one or more protection functions 
to a common “trip” to be transmitted to 
XCBR. 

In addition or alternatively, any combination 
of “operate” outputs of the protection 
functions may be combined to a new 
“operate” of PTRC.

SIML (Insulation 
medium supervision)

LN to supervise the insulation medium, for 
example the gas volumes of GIS (Gas 
Insulated Switchgear) regarding density, 
pressure, temperature, etc.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Voltage Transformer (VTR)

TVTR(Voltage 
Transformer)

There is one instance per phase. These 
three/four instances may be allocated to 
different physical devices mounted in the 
instrument transformer per phase.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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Current Transformer (CTR)

TCTR (Current 
Transformer)

There is one instance per phase. These 
three/four instances may be allocated to 
different physical devices mounted in the 
instrument transformer per phase.

SARC(Monitoring 
and diagnostics for 
arcs)

LN to supervise the gas volumes of GIS 
(Gas Insulated Switchgear) regarding arcs 
switching or fault arcs.

SPDC (Monitoring 
and diagnostics for 
partial discharges)

LN to supervise the gas volumes of GIS 
(Gas Insulated Switchgear) regarding 
signatures of partial discharges.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Q*

Power Overhead Line (LIN)

ZLIN (Power 
Overhead Line)

Supervised overhead line.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Rotating Reactive Component (RRC)

ZRRC (Rotating 
Reactive Component)

This LN controls reactive power flow.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Surge Arrestor (SAR)

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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ZSAR (Surge 
Arrestor)

Generic node for information exchange with 
surge arrestors.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Thyristor Controlled Frequency Converter (TCF)

ZTCF (Thyristor 
controlled frequency 
convertor)

Frequency conversion including AC/DC 
conversion.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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G* Generic references.

Thyristor Controlled Reactive Component (TCR)

ZTCR (Thyristor 
controlled reactive 
component)

Controls reactive power flow.

CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Power Transformer Winding (PTW)

G* Generic references.

Incoming Feeder Line (IFL)

Powered rules for the Incoming Feeder Link can be configured in the SLD editor.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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CALH (Alarm 
Handling)

For the communication, there is no 
difference between alarms and events if a 
time tag is added to any data transmitted.

If several events or alarms have to be 
combined to group alarms, a separate, 
configurable function is needed. The related 
LN may be used to calculate new data out of 
individual data from different logical nodes.

Remote acknowledgement with different 
priority and authority shall be possible. The 
definition and handling of alarms is an 
engineering issue.

G* Generic references.

Q*

Generator

Powered rules for the Generator can be configured in the SLD editor.

ZGEN (Generator) Generic node for information exchange with 
generators.

G* Generic references.

Table 45. Logical Node Classes and Primary Objects

Primary 
Object

Logical Node Class Mandatory Comment
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Revision History

This section provides information on the revision history of this User Manual.

The following table lists the revision history of this User Manual. 

Updates in Revision Index A
The following table shows the updates made in this User Manual for 800xA 5.1 
Rev A.

The revision index of this User Manual is not related to the 800xA 5.1 System 
Revision. 

Revision 
Index

Description Date

- Published for 800xA 5.1 June 2010

A Published for 800xA 5.1 Rev A. May 2011

B Published for 800xA 5.1 Feature Pack 4. February 2013

C Published for 800xA 5.1 Rev D. December 2013

D Published for 800xA 5.1 Rev E. July 2015

Updated Section/Sub-section Description of Update

Section 3 Working with Uploader User 
Interface

Multiple changes across the section.
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Updates in Revision Index B
The following table shows the updates made in this User Manual for 800xA 5.1 
Feature Pack 4.  

Updates in Revision Index C
The following table shows the updates made in this User Manual for 800xA 5.1 
Rev D.  

Updated Section/Sub-section Description of Update

Section 2 800xA IEC61850 OPC Server Included CET OPC Server related Information.

Section 3 Working with Uploader User 
Interface

IEC 61850 Uploader Options - Feature Pack Update

Section 5 Addition and Modification of 
Graphic Elements

A caution is provided to restrict the user from 
referring the usage of graphic elements for Feature 
Pack release. 

All Sections Multiple changes across all sections.

Appendix E - Sequence for Faceplates A caution is provided to restrict the user from 
referring the usage of graphic elements for Feature 
Pack release.

Appendix E - Logical Nodes and Primary 
Object

Contains the list of Logical Nodes connected to 
Primary objects. 

Updated Section/Sub-section Description of Update

The System Status Viewer Aspect A caution is provided restricting user not to perform 
other runtime operations while opening System 
Status Viewer aspect.

Update and Reload Configuration Steps provided to recover the CET project when 
computer crashes.
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Updates in Revision Index D
The following table shows the updates made in this User Manual for 800xA 5.1 
Rev E.

Upload Using Advanced Tab A caution is provided to upload a correct SCD file, if 
the SCD file contains special character (& or Space) 
in the description of any Conducting Equipment or 
Bay.

Latebind Mechanism Provided limitations regarding Late Binding using 
General Properties.

Updated Section/Sub-section Description of Update

Section 2 800xA IEC61850 OPC Server Information added on CET migration for revision 
releases.

Updated Section/Sub-section Description of Update
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